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Welcome to GIFTS 6.6
This publication includes all the information you need to install or 
upgrade your GIFTS system—including optional modules like the 
Internet Grant Application Module™ and GIFTS Plus Pack

Clients who have purchased GIFTS Connections™ products like 
MyGIFTS™ and ReviewerCONNECT™ should also refer to the 
GIFTS Connections: MyGIFTS and ReviewerCONNECT Installation and 
Technical Reference Guide.

In This Chapter
Contents of the MicroEdge GIFTS 6.6 Download ................. vii

Overview of the Installation or Upgrade Process.....................ix

Conventions Used in This Manual ......................................... xii

Using MicroEdge Documentation......................................... xiv

Using the Documentation ..................................................... xvi

Maintenance and Support Program...................................... xvii
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Contents of the MicroEdge GIFTS 6.6 
Download

Depending on your current GIFTS installation configuration, the 
MicroEdge download for GIFTS 6.6 can be used to install (or upgrade to) 
GIFTS 6.6, IGAM 6.0, GIFTS Connections 3.6, and/or GIFTS Plus Pack 
5.2.2 These products are described as follows.

GIFTS 6.6

GIFTS is a robust system for tracking proposals and grants from the time 
requests are received through closure. You can retrieve and classify requests, 
generate letters, manage contacts, schedule and monitor activities, maintain 
complete organization histories, track payments, and much more. 
Additional modules allow you to expand your GIFTS system to track 
different kinds of data and giving.

GIFTS is the foundation of the other MicroEdge products described here.

Internet Grant Application Module 6.0

IGAM enables grantmakers to accept grant applications and proposals 
through the Internet and allows grantmakers to create requirement forms 
for grantee reporting. IGAM can increase the quality of the grant 
submissions you review and significantly reduce the work required to 
process them. It can save time and lower your operating costs.

GIFTS Connections 3.6

The GIFTS Connections server (GCS) makes it possible to access and edit 
GIFTS data through a web browser. The server retrieves information from 
your GIFTS database and formats it for display in a web page.

In turn, GCS can also receive data from users connecting through the 
Internet and save it to GIFTS. This allows users to connect to your GIFTS 
system from anywhere, while your organization maintains a single database.
vii Contents of the MicroEdge GIFTS 6.6 Download



GCS is the hub of the GIFTS Connections suite of products. With the server 
translating data to browser-ready form—and back again—GIFTS 
Connections products designed for specific audiences are ready to be added:

MyGIFTS MyGIFTS is designed to give members and employees of your 
organization convenient and versatile access to GIFTS from remote 
locations. Whether connecting through an intranet or over the Internet, 
your users have a way to interact with GIFTS through their web browser.

ReviewerCONNECT ReviewerCONNECT is designed to give reviewers 
convenient access to your proposals from remote locations. Internal and 
external reviewers can provide instant feedback on proposals by editing and 
submitting review data through their web browsers.

GIFTS Plus Pack 5.2.2

The GIFTS Plus Pack is a set of .NET add-on utilities that integrate 
seamlessly into GIFTS to offer extensive options for updating batches of 
records, verifying tax status information, verifying watchlist information, 
updating and adding organizations, batch requirement and payment 
scheduling, enhanced charting, and enhanced e-mail capabilities. The 
utilities are built on the Microsoft .NET platform, and are accessed from 
within GIFTS for a seamless user experience.
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Overview of the Installation or Upgrade 
Process

Although the MicroEdge GIFTS Installation Disc (for new installs) or 
Upgrade Download will contain all of the data necessary to install these 
different systems, some products are installed in separate procedures. This 
section describes the order in which you must install these products.

!
Caution: Before upgrading, you should always make sure the backup of your 
database is up to date.

Part 1: Installing or Upgrading GIFTS and IGAM

The first part of the installation process is to install or upgrade GIFTS and 
the Internet Grant Application Module (if purchased). These two products 
are installed or upgraded simultaneously, along with optional GIFTS 
modules like the Budget Module and A/P Module.

Before installing or upgrading GIFTS and IGAM, you should read 
“Configuration Options” on page 2. This chapter details the GIFTS 
configuration options and describes the storage, performance, and 
installation considerations for each of these configurations.

If you’re installing GIFTS for the first time, choose the chapter containing 
instructions for your standalone or network setup:

Chapter Summary

“New GIFTS Standalone or 
File Server Installation” on 
page 21

Contains installation instructions for two different 
environments: a standalone system on a single 
computer, or a file server system with a GIFTS file 
server and one or more workstations.

“New Microsoft SQL Server 
Installation” on page 35

Describes how to install a multi-user GIFTS system 
with a Microsoft SQL Server database.

“New Oracle Server 
Installation” on page 57

Describes how to install a multi-user GIFTS system 
with an Oracle server database.
ix Overview of the Installation or Upgrade Process



If you’re upgrading to GIFTS 6.6 from Version 6.4 or 6.5, follow the 
instructions from the appropriate chapter:

!
Caution: If you have a version of GIFTS earlier than GIFTS 6.4, please contact 
MicroEdge Technical Support. If you attempt to upgrade an earlier GIFTS 
system, your database upgrade will fail and you will have to restore your 
backup of the GIFTS system.

If your configuration DOES NOT include MyGIFTS or 
ReviewerCONNECT or the GIFTS Plus Pack, your installation is complete 
after following the instructions referenced above.

If your configuration includes MyGIFTS/ReviewerCONNECT, it must be 
version 3.6 or later to be compatible with GIFTS 6.6 and IGAM 6.0.

“New Installation of GIFTS 
with Citrix Presentation 
Server” on page 79

Describes how to install GIFTS on a computer 
running Windows Terminal Services to provide user 
access to GIFTS through Citrix Presentation Server™.

Chapter Summary

“Upgrading a GIFTS 
Standalone Workstation or 
File Server” on page 89

Contains upgrade instructions for two different 
GIFTS setups: a standalone workstation, and a file 
server network.

“Upgrading GIFTS Client/
Server Installations” on 
page 105

Describes how to upgrade GIFTS in the SQL Server or 
Oracle server environment.

“Upgrading GIFTS with Citrix 
Presentation Server” on 
page 119

Describes how to upgrade GIFTS on a computer 
running Windows Terminal Services, providing user 
access to GIFTS through Citrix Presentation Server™.

Chapter Summary
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!
Caution: Use of a version of MyGIFTS/ReviewerCONNECT prior to 3.6 with 
GIFTS 6.6 and/or IGAM 6.0 will cause compatibility issues.

If you have an earlier version of MyGIFTS/ReviewerCONNECT, please 
upgrade to the GCS 3.6 version included with the GIFTS 6.6 upgrade 
download.

For information about installing or upgrading GIFTS Connections, please 
refer to the GIFTS Connections: MyGIFTS and ReviewerCONNECT Installation 
and Technical Reference Guide.

Percentage Coding Requirements

If you plan to use the new Percentage Coding feature included in GIFTS 6.6, 
the following requirements must be met.

❖ If IGAM is installed, you must have IGAM 6.0

❖ If MyGIFTS and ReviewerCONNECT is installed, you must have version 
3.6 or higher.

❖ If GIFTS Plus Pack is installed, you must have version 5.2.2 or higher.

Important: Percentage Coding does not require IGAM, GCS, or Plus Pack to 
be enabled. However, if you have any of these modules installed, they must 
be the proper versions for compatibility. If any of the above modules is not 
compatible, the Percentage Coding functionality will be disabled in GIFTS.
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Conventions Used in This Manual
Before you read this manual, it is helpful to familiarize yourself with the 
conventions used within. Doing so will enhance the usefulness of the 
documentation.

Note that the name “GIFTS” is used generically to refer to any 
configuration of the system, including the Essential GIFTS configuration.

Procedural and Typographic Conventions

This manual uses the following conventions to clarify the procedures and 
tasks it describes:

❖ Important procedures are always given as a numbered set of tasks. 

❖ Check marks indicate a checklist of general items or tasks.

❖ Characters given in this font are examples of data that you should enter, 
such as the directory path to a file. 

❖ Data elements within the GIFTS system are presented with an Initial 
Capital Letter. For example, the word “request” is capitalized when it is 
used to refer to a Request record within GIFTS.

Different Types of Notes

When appropriate, notes provide additional information or warnings that 
may apply to you. This manual uses four types of notes. Each type of note 
serves a unique purpose:

Note: A note with this format and the heading “Note” provides information 
that applies to some users. Notes apply to special situations. For example, a 
Note might explain minor differences in setup procedures among network 
and standalone systems.

Important: A note with this format and the heading “Important” provides 
information that applies to all users. This type of note provides information 
that is essential to the completion of a task.
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!
Caution: A note with this format and the heading “Caution” provides 
important information that applies to all users. Pay special attention to these 
notes.

Tip: A note with this format and the heading “Tip” provides useful 
information that applies to most users. Although Tips are not essential to 
the completion of a task, they provide alternative methods, shortcuts, or 
special applications relating to the procedures in the text. 
xiii Conventions Used in This Manual



Using MicroEdge Documentation
The GIFTS documentation provides step-by-step procedures and reference 
information on GIFTS features. These manuals assume you have a working 
knowledge of your operating system and its conventions, including how to 
use a mouse and standard menus.

Tip: The MicroEdge Solutions Knowledgebase, available on the MicroEdge 
website, provides quick and easy access to up-to-date technical information 
about MicroEdge products, including the information in your printed 
manuals.

GIFTS includes the following documentation:

GIFTS User’s Guide Describes how to use GIFTS to manage your giving: 
how to enter data, search for data, run reports from the GIFTS Organizer, 
and other grantmaking tasks.

GIFTS Installation and Technical Reference Guide Contains system 
requirements and detailed installation/upgrade procedures.

Note: This is the only printed guide you will receive. The rest of the 
documentation is available in .pdf format only. 

Using GIFTS Reports Describes how to run reports from the GIFTS Report 
Library. Includes a variety of sample reports for GIFTS and Employee 
GIFTS.

GIFTS Administrator’s Guide Describes how to set up and maintain your 
GIFTS system. This manual, which also describes how to use the optional 
GIFTS Customizer, should be read by the person within your organization 
designated as the GIFTS Administrator.

Related Documentation

If you use optional GIFTS modules such as Employee GIFTS or the Internet 
Grant Application Manager, you will receive additional documentation in 
.pdf format.
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GIFTS Plus Pack User’s Guide Describes how to use the GIFTS Plus Pack 
.NET Extension utilities.

Internet Grant Application Manager User’s Guide Describes how to review 
grant applications that have been submitted through the Internet and how 
to create requirement forms.

Import Module User’s Guide Describes how to import data from external 
systems into GIFTS.

MyGIFTS and ReviewerCONNECT Installation and Technical Reference Guide

Includes system requirements and detailed installation/upgrade 
procedures.

MyGIFTS User’s Guide Describes how to get the most out of your online 
GIFTS data access using MyGIFTS.

MyGIFTS Administrator’s Guide Describes how to set up GIFTS Connections 
and MyGIFTS to give users online access to GIFTS data.

Reviewers Module and ReviewerCONNECT User’s Guide Describes how to 
extend the functionality of the GIFTS Reviewers Module by granting 
reviewers online access to their reviews.

For more information on the resources available to you as a MicroEdge 
client, please refer to the MicroEdge Client Resource Guide.
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Using the Documentation
MicroEdge includes the GIFTS documentation with your download in 
Portable Document Format (PDF). To view these files, you will need the 
Adobe® Reader, which is available for free from Adobe Systems, Inc. at 
http://www.adobe.com.

You can print out selected pages, sections, chapters, or the entire book. You 
can also install the files on your computer or network so you can access 
them online, and take advantage of features such as a “hot” table of 
contents, index, and cross-references within books.

Tip: You can also obtain the most up to date PDF copies of the 
documentation from the MicroEdge PowerME site’s Content area. 

Note: The Adobe Reader’s other features are described in the Reader’s online 
Help. Note that MicroEdge does not provide technical support for the Adobe 
Reader. We cannot assist you with the installation, configuration, or use of 
this product. 
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Maintenance and Support Program
Members of MicroEdge’s Maintenance and Support Program receive 
unlimited telephone consultation on the use of the software, assistance in 
error isolation and correction, software updates, and prompt furnishing of 
any available problem solutions relating to the currently supported versions 
of GIFTS.

Our Technical Support staff are available Monday through Friday, 8:00 A.M. 
to 8:00 P.M. Eastern time. You may contact MicroEdge's Technical Support 
Specialists as follows:

Members may also search our library of documentation and technical 
bulletins on the GIFTS PowerME website. To access the Support Services 
webpage from GIFTS, choose Help ➤ MicroEdge on the Web ➤ MicroEdge 
Knowledgebase from the main menu.

For details about our support policies, please refer to the MicroEdge Client 
Resource Guide. If you have any questions regarding the Maintenance and 
Support Program, please contact our Client Administration Representative 
at 1-800-899-0890, option 6, then 2, who will be happy to assist you.

Phone 1-877-704-3343

Fax (212) 757-1784

Email helpdesk@microedge.com

Internet Login to PowerME and click Create New Case
xvii Maintenance and Support Program



1 Installation
Options and

Requirements
This chapter details the standalone, file server, and client/server 
configuration options of GIFTS—and describes the storage, 
performance, and installation considerations for each of these 
configurations.
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Installation Options and Requirements1

Configuration Options

The following implementations of GIFTS are available:

❖ A standalone version for a single workstation.

❖ A file server version for concurrent user access on a local area network 
(LAN).

❖ A high-performance client/server version for organizations with remote 
sites and a large number of concurrent users. The client/server versions 
are compatible with Microsoft SQL Server or Oracle server.

Note: With any of these configurations, you can install GIFTS on a computer 
running Windows® Terminal Services with Citrix® Presentation Server™ to 
make your GIFTS applications available from nearly any computer 
connected to your network or the Internet.

The following diagrams illustrate possible standalone, file server, and client/
server configurations. These diagrams indicate the network location of the 
GIFTS program files, database, and templates—as well as the location of 
other supporting programs and files. Knowledge of this design facilitates 
troubleshooting on network systems. 

Note: The number of concurrent users you may have is limited by the 
number of user licenses you have purchased.

In general, each box in these diagrams represents a computer, and lists the 
GIFTS components and supporting components resident on it. Possible 
exceptions or alternative configurations are listed with each example. 
2 Configuration Options



Installation Options and Requirements 1

Standalone System

On standalone (local) systems, all GIFTS components reside on a single 
workstation.

Optional Setup: Using Windows Terminal Services with Citrix Presentation 
Server, you can provide multi-user access to a standalone system.

Sample File Server Configuration

On file server systems, the GIFTS database resides on a file server and is 
accessed by one or more GIFTS workstations. Please note the following:

❖ By default, the GIFTS program files (EXEs) are installed on the file server. 
It is also possible to install these files on your workstations for increased 
performance.

❖ This example shows computers that access a GIFTS workstation using 
Citrix Presentation Server. For information about the software required 
to connect through the Presentation Server, please refer to documentation 
provided by Citrix. MicroEdge cannot provide support for Citrix products.

❖ In file server systems running on a peer-to-peer network, a single computer 
can act as both the file server and as a workstation. This workstation/file 
server is known as the master workstation. For detailed instructions for 
installing GIFTS on a peer-to-peer network, please search for “peer-to-
peer” in the MicroEdge Solutions Knowledgebase.
Configuration Options 3



Installation Options and Requirements1
Sample Client/Server Configuration

In the following example of a client/server configuration, the GIFTS 
database resides on the database server and the GIFTS program files are 
installed on file servers and remote workstations. Specifically, the GIFTS 
components are installed as follows:

❖ Database Server: the GIFTS database.

❖ File Servers: GIFTS program files (EXEs), report templates, 
correspondence templates.

❖ Headquarters & Field Workstations: GIFTS system files, ODBC drivers 
(used to connect to the database).
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Installation Options and Requirements 1

❖ Remote Workstations: GIFTS program files (EXEs), report templates, 

ODBC drivers (used to connect to the database).

Note: The file server and database server may reside on the same computer.

As with the standalone and file server configurations, clients with a client/
server system can provide access to GIFTS using Citrix Presentation Server.

Do I Need a Client/Server System?

Most GIFTS clients who use the product at a single site find that the file 
server version meets all of their requirements. MicroEdge recommends that 
you use the client/server version if any of the following apply to your 
system:

❖ a wide area network (WAN)

❖ more than 20 concurrent users

❖ a large volume of data (more than 30,000 grants)
Configuration Options 5



Installation Options and Requirements1

Note: Clients who use the client/server version of the product are responsible 
for purchasing the Oracle or Microsoft SQL Server software, the client/
server infrastructure, and support—including the services of a qualified 
Database Administrator.

MicroEdge makes no claims regarding improved performance. However, 
since the use of client/server technology transfers the task of processing 
queries from the workstation to the server, performance should be 
improved by eliminating the need to pass large amounts of data to the 
workstation for processing.

Logically, the larger the database, the larger the data sets used when running 
queries, so clients with large amounts of data should reap the most benefits. 
For the same reasons, this is the preferred approach for those who require 
remote database access.

Of the two available client/server options, the Microsoft SQL Server version 
is significantly easier to install, setup, and administer. Oracle server requires 
a higher degree of training and expertise. The primary reason that 
grantmakers choose Oracle is when it is their organization’s corporate 
standard and the staff resources are readily available. 

For more information about trading up to a client/server version of GIFTS, 
please refer to “System Trade-up and Migration” on page 144.

GIFTS Connections Configurations

For information about GIFTS Connections configurations that provide 
Internet access to GIFTS through MyGIFTS or ReviewerCONNECT, please 
refer to the GIFTS Connections: MyGIFTS and ReviewerCONNECT Installation 
and Technical Reference Guide.
6 Configuration Options
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GIFTS Storage Requirements

This section details the amount of disk space you will need for the various 
components of GIFTS 6.6. Since there are many possible configurations of 
GIFTS, the space needed for each GIFTS component is provided separately. 
For information about system requirements for GIFTS Connections, please 
refer to the GIFTS Connections: MyGIFTS and ReviewerCONNECT Installation 
and Technical Reference Guide.

Once you have determined which files you will be installing, you can use the 
guidelines in “Calculating Your Storage Requirements” on page 10 to 
calculate the requirements for each computer in your configuration.

GIFTS Directory Disk Space Requirements

This section details the contents of and the approximate amount of space 
needed for the GIFTS directory. 

Note: The requirements indicated for your correspondence templates are an 
estimate based on typical usage; if you have a large number of templates or 
use graphics in your templates, you may need more space for your templates.

❖ On a standalone workstation, the GIFTS directory resides on the local 
hard drive and contains the following files.

❖ In network installations, the GIFTS directory resides on the file server 
and includes all of the files installed for standalone systems, as well as the 

Program Files (EXEs) 150 MB

GCS Setup Files (including Job 
Manager files)
(clients with GIFTS Connections only)

50 MB

Other Setup Files (Crystal Reports, 
MDAC, and .NET, among others)

80 MB

Miscellaneous 20 MB

Report Templates 30 MB

Correspondence Templates 20 MB

Total 350MB
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Installation Options and Requirements1

setup files used to install GIFTS on your workstations and—for clients 
with GIFTS Connections—the files used to install GCS.

In some cases, your system administrator may decide to locate the GIFTS 
program files on each workstation’s hard drive instead of the file server to 
improve performance.

Note: The GIFTS directory also contains the IGAM folder used to store data 
for the optional Internet Grant Application Manager. If you use IGAM, be 
sure to add the IGAM requirements described in “IGAM Disk Space 
Requirements” on page 9 to your GIFTS directory total.

GIFTS Database Disk Space Requirements

This section details the amount of space needed for the GIFTS database:

❖ If you have a standalone or file server installation, the GIFTS database 
resides in your GIFTS directory. The database will start out quite small, 
about 2.5 megabytes, but will grow as you enter data. Make sure to 
anticipate the potential size of your database when calculating how much 
disk space you’ll need. In general, you should allocate about 20 megabytes 
for each 1,000 grants in the database.

❖ If you have a client/server installation, your database resides on the 
Microsoft SQL or Oracle server (not on your network server, unless they 
are the same). When you create the database, you assign an appropriate 
size to the database.

Program Files (EXEs) 150 MB

Miscellaneous 20 MB

Report Templates 30 MB

Correspondence Templates 20 MB

Workstation Setup Files 90 MB

GCS Setup Files (including Job 
Manager files)
(clients with GIFTS Connections only)

40 MB

Other Setup Files (Crystal Reports, 
MDAC, and .NET, among others)

70 MB

Total 420 MB
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A good rule of thumb is to allocate about 20 megabytes for each 1,000 
grants in the database, with an additional 25% of the database size for the 
log file. You should consider historical data, current data, and reasonable 
growth over the next several years when you calculate the appropriate 
database size.

Workstation Disk Space Requirements

This section details the approximate amount of space needed for the system 
files, GIFTS online help files, and Crystal Reports installed on each GIFTS 
workstation. 

IGAM Disk Space Requirements

The IGAM directory located within your GIFTS directory stores global 
settings, application forms, form image files, applications, and application 
attachments used with IGAM. If you use IGAM, you should include these 
disk space requirements in your calculation of the GIFTS directory size.

The space required for IGAM depends on your use of it. As a general 
guideline, you should set aside about 10 MB of disk space for every 100 
applications retrieved. Of course, if your application forms are designed with 
a large number of data fields—especially additional contacts and/or long 
text answers—your application size may increase considerably.

Another storage issue to consider is whether you accept file attachments 
from your applicants. If you accept attachments, you can adjust the attached 
file size limit for each form to help manage your projected storage capacity.

System Files 260 MB

Help Files 110 MB

Crystal Viewer 60 MB

Total 430 MB
GIFTS Storage Requirements 9



Installation Options and Requirements1

Calculating Your Storage Requirements

Use the following guidelines to calculate the requirements for your 
standalone, file server, or client/server system. The figures used are derived 
from the breakdown of requirements provided in the preceding section, 
“GIFTS Storage Requirements” on page 7.

If you intend to install a standalone GIFTS system, add the figures for the 
GIFTS directory, database, and workstation files. This is the amount of disk 
space required for you to install GIFTS on a single computer. For example:

If you intend to install GIFTS on a file server, add the figures for the GIFTS 
directory and your GIFTS database—the total is the amount of space 
required on your file server. Clients with IGAM should also include space 
needed to accommodate the growth of the IGAM directory. For example:

As detailed in “Workstation Disk Space Requirements” on page 9, each 
GIFTS workstation requires 105 MB of disk space for the GIFTS system files 
and online help files.

If you intend to install a client/server version of GIFTS, the amount of space 
indicated for the GIFTS directory—and the IGAM directory, if applicable—is 
required on your file server. The amount of disk space necessary on your 

GIFTS Directory 300 MB

Database + 40 MB (for 2,000 records)

Workstation Files + 250 MB

Total Installation = 590 MB

GIFTS Directory
(with workstation and GCS setup files)

400 MB

IGAM Directory + 200 MB (for 2,000 applications)

Database + 100 MB (for 5,000 records)

Total File Server = 700 MB
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database server should be established using the calculations specified for a 
client/server database.

Here is an example of the space requirements for a client/server system that 
includes IGAM; hardware and software requirements for GIFTS 
Connections are described in the GIFTS Connections: MyGIFTS and 
ReviewerCONNECT Installation and Technical Reference Guide.

GIFTS Database 500 MB (for 20,000 records)

GIFTS Database Log + 30 MB

GIFTS Database Server Total = 530 MB

GIFTS Directory
(with workstation and GCS setup files)

400 MB

IGAM Directory + 200 MB (for 2,000 applications)

GIFTS File Server Total = 600 MB

Each GIFTS Workstation = 430 MB
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Hardware Configuration Guidelines

The following sections detail the configuration guidelines for GIFTS 
workstations, GIFTS file servers, and the database server for a client/server 
implementation of GIFTS.

The compatibility information in this section is current as of February 2009. 
Please refer to the “GIFTS Compatibility Fact Sheet” on the GIFTS 
PowerME site for the latest and most comprehensive compatibility 
information.

Important: MicroEdge provides configuration guidelines for planning 
purposes only. Because there is such a wide range of variables that affect the 
performance of your system, MicroEdge assumes no responsibility for 
hardware and software purchasing decisions. Please consult your systems 
consultant before making specific configuration decisions.

GIFTS Workstations (Standalone or Networked)

The following system configuration guidelines apply to standalone GIFTS 
workstations and to GIFTS workstations in a network environment.

Processor (CPU) 2.0 GHz Pentium® 4 (or equivalent) computer. For optimal 
performance, use the fastest available processor

Memory (RAM) 1Gb of RAM

Disk Capacity Please refer to “GIFTS Storage Requirements” on page 7.

Operating 
Systems (32 or 64 
bit with latest 
service pack 
available)

❖ Windows 8

❖ Windows 7

❖ Vista

❖ Windows XP Professional

Monitor 1280 x 720 resolution with small fonts

Input Device Microsoft-compatible mouse.
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GIFTS File Servers

The following system configuration guidelines apply to the GIFTS file 
server on a local area network. The file server is the computer on which the 
GIFTS database, templates, reports, and other supporting files reside. 

Note: On client/server systems, the GIFTS database is usually located on a 
separate database server.

Upgrade/
Installation 
download

GIFTS installation files are provided to clients in the form of a 
compressed zip file download which must be extracted to a 
location on the workstation or server. Once extracted, it is usually 
required to run a setup.exe file to begin the installation process. In 
a networked environment, you do not need a copy of the files on 
every workstation; as long as the files are copied/extracted to a 
shared folder on the network you can install GIFTS. 

Processor (CPU) Contact your systems integrator to determine the appropriate 
processor needed to support GIFTS and all other file server 
applications. For optimal performance, use the fastest available 
processor.

Disk Capacity Please refer to “GIFTS Storage Requirements” on page 7.

Memory (RAM) Contact your systems integrator to determine the memory 
requirements for GIFTS and all other file server applications. 
More memory may improve performance or be required as your 
grants database grows.

Operating Systems 
(32 or 64 bit with 
the latest service 
pack available.)

Windows 2003 Server (including R2)

Windows 2008 Server (including R2)

Windows 2012 Server

New Installation or 
Upgrade files

GIFTS installation files are provided to clients in the form of a 
compressed zip file download which must be extracted to a 
location on the workstation or server. Once extracted, it is usually 
required to run a setup.exe file to begin the installation process. 
In a networked environment, you do not need a copy of the files 
on every workstation; as long as the files are copied/extracted to 
a shared folder on the network you can install GIFTS. 

Must be accessible from either the server or on any network-
connected workstation.
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GIFTS Client/Server Database Server

For client/server systems only: the following system configuration 
guidelines apply to the Microsoft SQL or Oracle server on which the GIFTS 
database resides.

IGAM Hardware Requirements

The GIFTS 6.6 installation program installs IGAM 6.0 for clients who have 
purchased it. IGAM is a Windows-based GIFTS module that requires an 
Internet connection to access applications that are stored on the MicroEdge 
IGAM server. The hardware requirements for managing your online 
application process through IGAM are:

Processor (CPU) Contact your systems integrator to determine the appropriate 
processor needed to support GIFTS and all other client/server 
applications. For optimal performance, use the fastest available 
processor.

Disk Capacity Please refer to “GIFTS Storage Requirements” on page 7.

Memory (RAM) Contact your systems integrator to determine the memory 
requirements for GIFTS and all other client/server applications. 
More memory may improve performance or be required as your 
grants database grows.

Organizations running the client/server version of GIFTS as the 
exclusive application on their SQL server have typically installed 
either 128MB or 256MB of RAM on the server. 

Client/Server 
Database Software

 Microsoft SQL Server 2000 to 2012 (including R2)

Oracle server 10g (Release 10.2) or 11.1 (Release 11.1)

New Installation or 
Upgrade files

GIFTS installation files are provided to clients in the form of a 
compressed zip file download which must be extracted to a 
location on the workstation or server. Once extracted, it is usually 
required to run a setup.exe file to begin the installation process. 
In a networked environment, you do not need a copy of the files 
on every workstation; as long as the files are copied/extracted to 
a shared folder on the network you can install GIFTS. 

Must be accessible from either the server or on any network-
connected workstation.
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GIFTS-configured workstation Since IGAM is a GIFTS module, it must be 
run from a GIFTS workstation. This allows IGAM to access the GIFTS 
database and utilize your existing GIFTS permissions and security settings.

Internet connection To activate an application form, its data must be 
uploaded to the MicroEdge IGAM server from your workstation through an 
active Internet connection. Completed applications are stored on the 
MicroEdge IGAM server and must be downloaded through your Internet 
connection. While any dial-up or broadband connection will work, keep in 
mind that a dial-up connection may be impractical if you expect to receive a 
large volume of applications and/or applications with attachments.

Ability to make outgoing connections through Port 80 Form and application 
data is transmitted to and from the MicroEdge server in XML format over 
HTTP. To upload form data and download application data, your firewall 
must allow outgoing HTTP traffic through Port 80, the industry standard 
configuration for web access.

Note: IGAM uses SSL encryption whenever possible to secure the data being 
transmitted over your Internet connection. To take advantage of SSL 
encryption, your firewall must allow outgoing HTTPS traffic over Port 443. 
If Port 443 is not available, please contact Technical Support.

Disk space Please refer to “IGAM Disk Space Requirements” on page 9 for 
information about the disk space requirements for IGAM.

Internet Access

MicroEdge clients with current Maintenance and Support contracts can 
access MicroEdge’s full range of technical support services over the Internet. 
From MicroEdge’s website (http://www.microedge.com), you can login to 
GIFTS PowerME to download the latest GIFTS maintenance releases and 
access technical information in the MicroEdge Solutions Knowledgebase.

In order to use these services, you need an Internet connection and browser.

GIFTS Upgrades

An Internet connection is required for the download of all GIFTS product 
upgrades which are in the form of a compressed zip file. The zip file is 
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extracted to a folder on a workstation or server and a setup.exe file is run to 
begin the installation process. Clients scheduled for an upgrade will receive 
specific download and installation instructions via email.
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Performance Considerations

There are many factors that affect overall system performance. The factors 
that typically have the greatest impact on GIFTS performance include, but 
are not limited to:

❖ Workstation and/or server processor speed and memory

❖ Microsoft® Windows® configuration and optimization

❖ The size of your database

❖ Network topology, cable type, capacity, and traffic

❖ The number of concurrent GIFTS users

❖ The load that other applications place on your server or servers
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Software Considerations

All software that interacts with GIFTS must be certified for use with GIFTS 
to ensure proper performance. For a complete list of compatible products, 
please refer to the “GIFTS 6.6 Compatibility Fact Sheet” on the PowerME 
website. 

Please review and consider the following information about access rights, 
word processor version control, Crystal Reports, software backups, system 
files, and Oracle table names.

Server Access Rights

GIFTS requires that all users have full access rights to the GIFTS directory 
and all of its subdirectories.

Word Processor Version Control

GIFTS makes extensive use of Microsoft’s OLE technology to enable the 
automated production of correspondence using compatible versions of 
Microsoft Word. However, different versions of Word may handle 
embedded merge fields differently. 

Important: MicroEdge strongly recommends that you install the same 
version of Microsoft Word Professional on all GIFTS workstations and, if 
applicable, computers running the MyGIFTS Job Manager.

If you use GIFTS at different sites on a wide area network (WAN) and you 
have different versions of Word at each site, each site must use separate 
correspondence templates that are specific to the version of Word used at 
that site.

Be aware that users with different versions of Word cannot share the letter and 
write-up templates used to create correspondence from GIFTS. In addition, the use 
of more than one version of Word can significantly complicate the support 
and troubleshooting of your system. 

When you upgrade Microsoft Word, you may have to update your GIFTS 
correspondence templates. There may be specific steps necessary to 
successfully “upgrade” your templates for continued compatibility with the 
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GIFTS mail merge functions. Whenever you plan to upgrade your word 
processing software, be sure to contact MicroEdge Technical Support for 
further information.

Crystal Reports Version Control

GIFTS uses a Business Objects™ Crystal Reports viewer to generate many 
of the standard reports provided with GIFTS. If you plan to install GIFTS on 
any computer that also runs Crystal Reports, or vice versa, please refer to 
“Compatibility with Crystal Reports” on page 164.

System Backups

MicroEdge strongly recommends that you take the following precautions to 
protect your grantmaking data:

❖ Back up your GIFTS system daily using high-capacity tape or other 
archival media.

❖ Store backups in secure locations, both on-site and at a remote location.

❖ Use industry-standard products that enable reliable and verified file 
backups and quick restores. 

❖ Configure your backup software to back up open files. This ensures that 
the GIFTS database is backed up even if users are logged in while the 
backup processes are running.

For detailed information about backing up GIFTS, please search for 
“backups” in the MicroEdge Solutions Knowledgebase. 

System Files

GIFTS has been designed to work with the compatible word processor, 
spreadsheet, email, and accounting software of your choice. In order for 
these products—and all other software on your computers—to work 
together properly, they need to be carefully installed, optimized, and tested. 
In some cases, conflicts between applications may require troubleshooting 
and resolution by your internal technical support staff.
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Problems may occur when an application installs an older version of a 
system file (such as a DLL or OCX file) over a newer version used by 
another application. MicroEdge provides a diagnostic utility that identifies 
the system files installed by GIFTS and their current properties. For more 
information about this utility, please refer to “Maintenance, Security, and 
Data Integrity” on page 129.

Note: MicroEdge technical support staff can attempt to assist clients with 
Maintenance and Support contracts to identify and resolve GIFTS-related 
system file problems that affect more than one workstation. However, 
clients are responsible for resolving environmental issues. For more 
information about MicroEdge’s support policy, please refer to the MicroEdge 
Client Resource Guide.

The “Installation Impact Analysis” on page 149 lists the system files installed 
for GIFTS. This valuable reference identifies the name, date, size, and 
location of each file, and can be used to identify potential conflicts or to 
troubleshoot system errors.

Oracle Database Tables and Names

The grants database on Oracle server versions of GIFTS may reside on a 
database applications server with other Oracle databases. Compatibility 
among these databases must be carefully considered if you plan to use a 
single database server for both GIFTS and other databases.

Important: Please contact Tech Support for the default LoginID/owner 
name and password. Ensure that no other objects (tables, aliases, etc.) on 
the database server have both the same name and the same owner as that of 
any GIFTS table.  No conflicts occur if another table shares the same name 
or alias as a GIFTS table, but the two tables must have different owners.

Please refer to the GIFTS 6.6 Database Schema for a full list of the tables 
included in GIFTS 6.6.
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Standalone or File
Server Installation

This chapter describes the process for a new installation of GIFTS on 
a standalone workstation or a file server system with an Access 
database.

In This Chapter
Before You Begin.................................................................... 22

New Standalone Installation .................................................. 24

File Server Installation............................................................ 28



New GIFTS Standalone or File Server Installation2

Before You Begin

The following important points should be addressed before you install 
GIFTS:

❖ Please read this entire chapter carefully. You should understand the entire 
installation process before you begin.

❖ If Crystal Reports is installed on any computer on which you plan to install 
GIFTS, please see “Compatibility with Crystal Reports” on page 164.

❖ GIFTS uses Microsoft Word to produce correspondence and write-ups. 
Please make sure that a compatible version of Microsoft Word has been 
correctly installed and is currently functioning without errors.

❖ Install the latest proven service packs for Windows and your device drivers 
(such as video drivers and printer drivers).

❖ If you use virus-protection software, please make sure that it is disabled 
before attempting to run the installation. An active virus-protection 
program may cause errors during the installation process.

❖ Read the following sections, “About the Standalone Installation 
Process”and “About the File Server Installation Process”, to determine the 
type of installation that you need to perform.

The above points are vital towards insuring that your installation is 
successful. Please make sure that each issue has been thoroughly addressed 
before continuing.

About the Standalone Installation Process

This type of installation is for clients who have purchased a single-user 
version of GIFTS. It installs the entire GIFTS system on the local hard drive 
of a single workstation, and only this workstation will have access to GIFTS. 
To perform this type of installation, please follow the instructions in “New 
Standalone Installation” on page 24.
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About the File Server Installation Process

This installation installs GIFTS on a network file server and one or more 
workstations. Please be aware that the number of concurrent users is limited 
by the number of user licenses you have purchased.

This installation includes two parts: a Server Installation process—which 
installs shared files, including the GIFTS database, on the server—and a 
Workstation Installation, which installs files to each workstation and connects 
each workstation to the GIFTS system on the server.

To perform this type of installation, please follow the instructions in “File 
Server Installation” on page 28.

System Files

For a complete list of the system files installed by the GIFTS setup process, 
please refer to the “Installation Impact Analysis” on page 149.

How to Obtain Technical Support

If you have any problems during your installation, please contact MicroEdge 
Technical Support.

❖ by submitting an electronic support request. Go to 
http://www.microedge.com/support and log in to the PowerME support 
website.

❖ by email at helpdesk@microedge.com

❖ by phone at (877) 704-3343

❖ by fax at (212) 757-1784
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New Standalone Installation

This type of installation is for clients who have purchased a single-user 
version of GIFTS or Essential GIFTS. It installs the entire GIFTS system on 
the local hard drive of a single workstation; only this workstation will have 
access to GIFTS.

Step 1: Copying Your GIFTS Configuration File

This procedure describes how to copy the configuration file for your GIFTS 
system from your extracted GIFTS download to the proper location on your 
computer. This file must be available during the installation process.

1 Copy the gifts.cfg file to a convenient location on your hard drive. Make 
a note of this location: you will need to know it when you install GIFTS.

2 Right-click on your new copy of the gifts.cfg file and select Properties.

3 On the General tab of the properties window, clear the check box for the 
Read-only option. (If the Read-only option is already off, you do not need 
to make any changes.)

4 Click OK to save the gifts.cfg properties.

Step 2: Installing GIFTS

Before You Begin: To avoid software conflicts, close all other applications on the 
workstation.

1 Access the Install subfolder of the extracted GIFTS files and run the 
Setup.exe. The GIFTS Welcome screen is displayed.

Note: Throughout the installation, you can click the Next button to continue, 
the Back button to return to the previous screen, or the Cancel button to 
cancel the installation.

2 Click Next. The Select Setup Type window opens.
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3 Select the “Local Installation (single user)” option and click Next. The 

Choose Destination Location window indicates that GIFTS will be 
installed in C:\GIFTS, the recommended location.

Note: If you want to install GIFTS to a different location on your 
workstation, click Browse and select the destination folder.

4 Click Next. The Configuration window prompts you to specify the 
location of your GIFTS configuration file.

5 Click Browse and browse to the directory that contains your gifts.cfg file. 
Then, click OK. You are prompted to select the word processor you would 
like to use with GIFTS.

6 Select Microsoft Word, and click Next. You are prompted to choose where 
you want the GIFTS program icons to be displayed in the Windows Start 
menu.

7 Click Next. The Start Copying Files window displays a summary of the 
installation options you chose. The Current Settings field should indicate 
that a “Local GIFTS Installation” is to take place in the folder you specified.

8 If the options are correct, click Next. The installation begins.

9 If your computer is not running a compatible version of the Microsoft Data 
Access Components (MDAC) software needed to run GIFTS, you are 
prompted to install it. Click OK and follow the on-screen instructions to 
complete the MDAC installation.

Note: After the MDAC installation, a message may inform you that your 
computer must be restarted to continue. Agree to the restart. After the 
computer has restarted, the setup program continues at step 9.

10 When the installation is complete, you are notified. Click Finish.

GIFTS is now installed. Please proceed to the next section to complete your 
setup.
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Step 3: Configuring Windows for Use with GIFTS

If you are going to use GIFTS to create correspondence in Microsoft Word, 
please use the following procedure to set up Microsoft Windows so that 
GIFTS and Word can share data properly:

1 Open the Windows Explorer.

2 From the Explorer menu, choose Tools ➤ Folder Options, View ➤ 
Folder Options, or View ➤ Options (the name of the menu item is 
different for different versions of Windows).

Note: In Microsoft Vista/7/8, from the Explorer menu, choose Organize 
➤ Folder and Search Options.

3 Go to the View tab (if applicable).

4 Ensure that the “Hide file extensions for known file types” or “Hide MS-
DOS file extensions for types that are registered” check box is not selected. 
Use of this option can interfere with the way in which Microsoft Word 
merges data from GIFTS.

Important: After installing GIFTS on any workstations running Windows 
Vista/7/8, and before logging into GIFTS, you should give the workstation 
user full permissions to the gifts.ini file in the C:\WINDOWS directory. If 
you do not do this and log into GIFTS, the updated gifts.ini file is stored in 
the following location: C:\Users\[user name]\AppData\Local\VirtualStore 
\Windows. If you need to make any changes to the gifts.ini file, do so from 
this location. 

Your single-user installation of GIFTS or Essential GIFTS should now be 
complete: enjoy!
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Logging in to GIFTS for the First Time

To ensure that your installation has been successful, you can log in to a 
GIFTS workstation by entering Admin as the Login ID. No password is 
required.

Important: The Admin login allows full access to all areas of the GIFTS 
system; be sure to set up Login IDs and passwords when you set up GIFTS 
for your organization, as described in the GIFTS Administrator’s Guide.
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File Server Installation

This type of installation installs GIFTS or Essential GIFTS on a network file 
server and one or more workstations. Note that the number of users that 
can log in to GIFTS at any given time cannot exceed the number of user 
licenses that you have purchased.

In a network environment, GIFTS must be installed on the file server first:

❖ The Server Installation procedure installs the database, program files, and 
report template files to the network directory that you specify. This part 
of the installation is run only once using the MicroEdge GIFTS Installation 
Disc, and can be run from any workstation.

Note: The server installation also performs a workstation installation on 
the computer from which you run it. Run the server installation from a 
computer that you plan to use as a GIFTS workstation.

❖ Then, you can use the Workstation Installation procedure to install GIFTS 
on all other workstations that are to have access to GIFTS. This procedure 
installs the workstation files needed to run GIFTS.

Prerequisites for File Server Installations

Before beginning the file server installation, make sure that you have met 
the following prerequisites.

❖ Please make sure you have access to an in-house network administrator, 
or a consultant familiar with your network environment, who has full 
network administrative access rights.

❖ The user installing the system must have the access rights needed to create 
a directory on the target drive where GIFTS will be installed.

❖ All users of GIFTS must have full access rights to the network directory 
where the GIFTS system is to be installed.

❖ For clients using Novell network server, increase the Record Locking 
Threshold per Connection to 10,000. This will prevent the server from 
exceeding the maximum “record locking threshold” during the use of the 
GIFTS database. 
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For more information on increasing this Novell setting, please consult 
with your LAN administrator.

Once you have verified that these prerequisites have been met, you may 
proceed to the next section, “Copying Your GIFTS Configuration File”.

Copying Your GIFTS Configuration File

This procedure describes how to copy the configuration file for your GIFTS 
system from your GIFTS files to your computer. This file must be available 
during the installation process.

1 Copy the gifts.cfg file to a convenient location on your file server’s hard 
drive. Make a note of this location: you will need to know it when you 
install GIFTS.

2 Right-click on your new copy of the gifts.cfg file and select Properties.

3 On the General tab of the properties window, clear the check box for the 
Read-only option. (If the Read-only option is already off, you do not need 
to make any changes.)

4 Click OK to save the gifts.cfg properties.

Installing GIFTS on Your File Server

In a network environment, you must first install the GIFTS database, 
program files, and template files on your file server. On any computer you 
plan to use as a GIFTS workstation, use the following procedure to install 
these files:

Before You Begin: To avoid software conflicts, close all other applications on the 
workstation.

1 Navigate to the location where you extracted the GIFTS 6.5 installation 
files and access the Install subfolder. Run the Setup.exe file. The GIFTS 
Welcome screen is displayed.
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Note: If the GIFTS Welcome screen is not displayed, run the Setup.exe file 
located in the Install folder of the Installation Disc.

Throughout the installation, you can click Next to continue, Back to 
return to the previous screen, or Cancel to cancel the installation.

2 Click Next. The Select Setup Type window opens.

3 Select the “Network Installation” option and click Next. The Choose 
Destination Location window opens.

4 Click Browse and specify the location of the GIFTS directory. You should 
choose a network location that will be accessible to all the workstations 
that will run GIFTS.

Example: You want to install GIFTS on the P: drive of your network file 
server. Enter P:\GIFTS after clicking Browse. The GIFTS database, 
program files, correspondence templates, and report templates will be 
copied to that folder (the “GIFTS directory”). If prompted that this folder 
does not exist, click Yes to create it.

5 After specifying the location of the GIFTS directory, click Next. The 
Configuration window prompts you to specify the location of your GIFTS 
configuration file.

6 Click Browse and browse to the directory that contains your gifts.cfg file. 
Then, click OK. You are prompted to select the word processor you would 
like to use with GIFTS.

7 Select Microsoft Word, and click Next. You are prompted to choose where 
you want the GIFTS program icons to be displayed in the Windows Start 
menu.

8 Click Next. The Start Copying Files window displays a summary of the 
installation options you chose. The Current Settings field should indicate 
that a “GIFTS Server Installation” is to take place in the folder you 
specified.

9 If the options are correct, click Next. The installation begins.

10 If your file server is not running a compatible version of the Microsoft Data 
Access Components (MDAC) software needed to run GIFTS, you are 
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prompted to install it. Click OK and follow the on-screen instructions to 
complete the MDAC installation.

Note: After the MDAC installation, a message may inform you that your 
computer must be restarted to continue. Agree to the restart. After the 
computer has restarted, the setup program continues at step 10.

11 When the installation is complete, you are notified. Click Finish.

You are ready to proceed to the workstation installation procedure described 
in the next section.

Workstation Installation

After installing GIFTS on your file server, you must install GIFTS on each 
workstation that is to have access to GIFTS. Use this procedure on each 
workstation to install the files needed to run GIFTS.

Reminder: The workstation from which you ran the server installation is 
already set up as a GIFTS workstation.

As part of the Server Installation, the workstation setup program was 
installed in the GIFTS directory on your network; be sure to run your 
workstation installations from the network, not from the Installation Disc.

1 Run the Setup.exe file located within the GIFTS\Setup directory on your 
file server.

Example: If you designated P:\GIFTS as your GIFTS directory, the Setup.exe 
file is located at P:\GIFTS\Setup\Setup.exe.

The GIFTS Welcome screen is displayed.

2 Click Next. The Select Program Folder window opens.

3 In the Select Program Folder window, choose where you want the GIFTS 
program icons to be displayed in the Windows Start menu, then click 
Next. The Start Copying Files window opens.
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4 Read the summary provided of the installation options you chose. The 

Current Settings field should indicate that a “GIFTS Workstation 
Installation” is to take place in the folder you specified.

If the options are correct, click Next. The installation begins.

5 If the workstation is not running a compatible version of the Microsoft 
Data Access Components (MDAC) software needed to run GIFTS, you 
are prompted to install it. Click OK and follow the on-screen instructions 
to complete the MDAC installation.

Note: After the MDAC installation, a message may inform you that your 
computer must be restarted to continue. Agree to the restart. After the 
computer has restarted, the setup program continues at step 6.

6 When the installation is complete, you are notified. Click Finish.

GIFTS is now installed on the workstation. If you are going to use GIFTS to 
create merged correspondence in Microsoft Word, please use the following 
procedure to set up Microsoft Windows so that GIFTS and Word can share 
data properly:

1 Open the Windows Explorer.

2 From the Explorer menu, choose Tools ➤ Folder Options, View ➤ Folder 
Options, or View ➤ Options (the name of the menu item is different for 
different versions of Windows).

Note: In Microsoft Vista, from the Explorer menu, choose Organize ➤ 
Folder and Search Options.

3 Go to the View tab (if applicable).

4 Ensure that the “Hide file extensions for known file types” or “Hide MS-
DOS file extensions for types that are registered” check box is not selected. 
Use of this option can interfere with the way in which Microsoft Word 
merges data from GIFTS.

Important: Be sure to repeat the entire Workstation Installation process on 
each workstation that should have access to GIFTS. Ensure that all users have 
full access permissions for the GIFTS directory and all of its subdirectories.
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Your installation of GIFTS or Essential GIFTS should now be complete: 
enjoy!

Logging in to GIFTS for the First Time

To ensure that your installation has been successful, you can log in to a 
GIFTS workstation by entering Admin as the Login ID. No password is 
required.

Important: The Admin login allows full access to all areas of the GIFTS 
system; be sure to set up Login IDs and passwords when you set up GIFTS 
for your organization, as described in the GIFTS Administrator’s Guide.
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Before You Begin

Please address the following important points before you install GIFTS:

❖ Please read this entire chapter carefully. You should understand the entire 
installation process before you begin.

❖ The installation process creates several network directories. Make sure 
that you have the necessary permissions to create these directories.

❖ GIFTS uses Microsoft Word to produce correspondence and write-ups. 
Please make sure that a compatible version of Microsoft Word has been 
correctly installed and is currently functioning without errors.

❖ If you use or intend to use Crystal Reports, make sure to read 
“Compatibility with Crystal Reports” on page 164.

❖ If you use virus-protection software, please make sure that it is disabled 
before attempting to run the installation. An active virus-protection 
program may cause errors during the installation process.

The above points are vital towards ensuring that your installation is 
successful. Please make sure that each issue has been thoroughly addressed 
before continuing.

System Files

For a complete list of the system files installed by the GIFTS setup process, 
consult the “Installation Impact Analysis” on page 149.

How to Obtain Technical Support

If you have any problems during your installation, please contact MicroEdge 
Technical Support.

❖ by submitting an electronic support request. Go to 
http://www.microedge.com and log in to the PowerME website.

❖ by email at helpdesk@microedge.com

❖ by phone at (877) 704-3343

❖ by fax at (212) 757-1784
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Overview of the GIFTS Installation Process

The procedures outlined below will take you through the entire process of 
installing the GIFTS 6.6 client/server edition for Microsoft SQL Server. The 
installation consists of the following major steps; each step corresponds to a 
section in this chapter.

Please follow these steps in the order in which they are presented. 
Addressing the steps in any other order will prevent your installation from 
being successful.

Step 1: Important Prerequisites In this step, you are asked to verify that you 
have the appropriate staff necessary for the installation process and that your 
SQL Server has been configured to accommodate the GIFTS system. It also 
outlines prerequisites for your network environment.

Step 2: Setting Up the GIFTS Database This portion of the installation is 
used to create the GIFTS database on the Microsoft SQL Server. This 
requires the services of a trained SQL Server Administrator who is familiar 
with all aspects of setting up and administering Microsoft SQL Server.

Step 3: Installing GIFTS on Your File Server In this step, you will install the 
GIFTS program onto a network drive that is accessible to all workstations 
that will use GIFTS. This procedure also configures the workstation you’re 
using as a GIFTS workstation.

Step 4: Populating the GIFTS Database This step creates the table definitions 
for the GIFTS database on the SQL Server, and populates that database with 
system-defined data necessary to the operation of GIFTS.

Step 5: Installing the GIFTS Workstations This step configures your other 
workstations to run GIFTS. (The workstation on which you performed Step 
3 is already configured to be a GIFTS workstation.)

Step 6: Logging in to GIFTS for the First Time This step describes how to log 
in to GIFTS, verifying that your installation has been successful.
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Step 1: Important Prerequisites

The following prerequisites must be met before you begin your GIFTS 
installation. Please note that MicroEdge Technical Support staff will only be 
able to assist you in troubleshooting your installation once all of these 
prerequisites have been met.

MicroEdge Technical Support staff can only assist you in matters related 
exclusively to the installation of GIFTS software. For matters relating to 
your hardware, network, and the installation of Microsoft SQL Server, 
please consult with the appropriate vendors.

Prerequisites for the SQL Server Environment

Please attend to the following before beginning your installation:

✔ Make sure you have access to the services of a trained SQL Server 
Administrator familiar with all aspects of setting up and administering the 
SQL Server environment. MicroEdge Technical Support personnel 
cannot provide advice or assistance related to the setup of your SQL Server 
software and/or hardware.

✔ Ensure that your Microsoft SQL Server is properly installed and connected 
to your network, and that all desired client workstations can connect to it 
using the SQL Server Management Studio.

✔ Ensure that all computers you plan to use with GIFTS have adequate 
storage space and hardware, as described in “GIFTS Storage 
Requirements” on page 7 and “Hardware Configuration Guidelines” on 
page 12.

✔ GIFTS requires an ODBC driver on each workstation to connect to the 
SQL Server. These drivers are installed by the GIFTS Setup program. 
Refer to the GIFTS 6.6 and GCS 3.6 Compatibility Fact Sheet on the 
PowerME website at http://www.microedge.com for a list of compatible 
drivers.

To check the version of the ODBC driver installed on a workstation, you 
can use the “Data Sources (ODBC)” Control Panel.
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✔ The maximum number of concurrent user connections allowed by the 

database server should be at least five times the number of GIFTS, 
MyGIFTS, and ReviewerCONNECT users. To adjust this setting:

❖ In the SQL Server Management Studio, right-click on the server and 
select Properties. Then, go to the Connections page.

✔ Configure your SQL Server to allow SQL Server authentication:

❖ In the SQL Server Management Studio, right-click on the server and 
select Properties. Then, go to the Security page and select the “SQL 
Server and Windows Authentication mode” option.

Prerequisites for Your Network Environment

Please attend to the following before beginning your installation:

✔ Make sure you have access to an in-house network administrator, or a 
consultant familiar with your network environment, who has full network 
administrative access rights.

✔ The user installing the system must have the permissions needed to create 
a directory on the target drive where the GIFTS file server will be installed.

Other Installation Considerations

Please consider the following while installing GIFTS:

✔ We recommend that you create your GIFTS database with the following 
Collation Name: SQL_Latin1_GENERAL_CP1_CI_AS.

Be sure to specify this collation at both the database and table/field levels; 
queries may run slowly if there is a mismatch among the collation methods 
specified in your database. Also, if you are using SQL to migrate GIFTS 
data from one server to another, you should make sure that the new GIFTS 
database on the destination SQL server has the same collation settings as 
the GIFTS database from the source SQL server. 

If you choose a different Collation Name, you must use one that includes 
a character set that is a superset of the recommended Collation Name’s 
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character set. If you use a character set that does not include all the 
characters the GIFTS database is programmed to use, your GIFTS system 
may not work properly. A different Collation Name may also include a 
different sort order.

Important: The Collation Name recommended above is the only one with 
which GIFTS has been tested and certified SQL Server 2008or later. We 
will support GIFTS when used with other Collation Names. However, be 
aware that if your choice creates issues in the GIFTS system, the only 
solution our support staff may be able to offer is to change to the 
recommended setting.

✔ To run GIFTS, all GIFTS users must have full access rights to the GIFTS 
directory that you install on your file server. Be sure to grant these rights 
as you set up your GIFTS workstations.

Once you have verified that these prerequisites have been met, you may 
proceed to “Step 2: Setting Up the GIFTS Database”.
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Step 2: Setting Up the GIFTS Database

This step creates a new SQL Server database and database login for GIFTS, 
and should be performed by a trained SQL Server Administrator familiar 
with all aspects of setting up and administering the SQL Server 
environment.

During the creation of your database, you define the initial size of your 
database and database log. In general, you should allocate about 20 MB for 
each 1,000 grants in the database, with an additional 25% of the database 
size for the log file. Take your historical data, current data, and projected 
growth over the next several years into consideration when you calculate 
the database size.

Example: If your organization processes 1,000 grant requests per year, and you 
have five years of historical data, you should allocate approximately 200 MB 
for your database device (100 MB for your historical data and 100 MB for the 
next five years). 

During times of peak data entry, the database log can grow quite large and 
will eventually reach its size limit (if you establish a limit). The log should be 
monitored closely, backed up, and dumped on a regular basis, according to 
your SQL Server documentation. 

Managing Database Recovery and the 
Transaction Log

GIFTS performs a dump of the transaction log prior to performing batch 
processes. 

Note: If you are using SQL 2008 (or later) or want point of failure recovery, 
you must do the following:

❖ Manually uncheck the Dump Transactions Log option in the 
Administrator Module's Preferences>General settings.  

❖ You will need to shrink the Transaction Logs manually on a regular 
basis if on Simple recovery mode. If using Full recovery mode, you 
will need to set the recovery mode to Simple, shrink the file, and then 
set the recovery mode back to Full.
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Configuring the transaction log dump is part of managing your database 
recovery. The database recovery preference you choose determines how the 
transaction log is managed. The selection and management of this 
preference is entirely the responsibility of the client.

MicroEdge recommends choosing 'Simple' or 'Full' as your database 
recovery preference ('Full' is the SQL default). 

❖ If you want your SQL server to automatically manage your transaction 
log, we recommend setting this preference to 'Simple.'

❖ If you want to manually manage your transaction log, choose 'Full.' 

For more information about manually managing your transaction log, 
please consult your Microsoft SQL Server documentation.

To set your database recovery preference:

1 From your GIFTS database icon, right-click and select Properties.

2 Click the Options tab.

3 In the Recovery Model field drop-down menu, select ‘Simple’ or ‘Full.’

4 Click OK. 
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If you are using SQL 2008 or later, you must indicate to GIFTS that you 
want to turn off transaction log dumping. If you are using an earlier version 
of SQL and want point of failure recovery, you must also do this.

To turn off transaction log dumping:

1 From the Preferences Editor in the Administrator module, double-click 
Preferences in the System section.

2 At the bottom of the Preferences field, enter ‘DumpTransactions=0.’

3 Click OK.

Creating the GIFTS Database and Login
(for SQL Server 2008 or later)

The following procedures create the GIFTS database and database login for 
SQL Server 2008 or later systems. 

Step 2a: Creating the GIFTS Login This step creates the Login ID used by 
the GIFTS system to connect to the GIFTS database. Note that the default 
Login ID and password must be used.

Note: If you want to change the password, you may do so after you install 
GIFTS. Note that when you change the password on the server, you must 
also update the database login information in the GIFTS.SYS or gifts.ini file. 
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For details on updating the Client/Server login ID and password in GIFTS, 
please refer to the GIFTS Administrator's Guide.

To create the Login ID:

1 Log in to the SQL Server Management Studio.

2 On the left panel of the Management Studio, click the plus sign to expand 
the server for which you wish to create the GIFTS login.

3 In the list that appears, click the plus sign to expand the Security folder.

4 Right-click the Logins folder and select New Login from the menu. The 
New Login window opens.

5 In the Login name field of the General page, enter the loginID

6 Select the SQL Server Authentication option.

7 De-select the “Enforce password policy” option, and verify that the 
“Enforce password expiration” and “User must change password at next 
login” options are also turned off. 

8 Enter the password.

Important: SQL Server 2008 passwords are case-sensitive.

9 Click OK to save the login.

Please continue to Step 2b to create the GIFTS database.

Step 2b: Create the GIFTS Database and Transaction Log This step creates 
the database named GIFTS and its transaction log.

1 Log in to the SQL Server Management Studio.

2 On the left panel of the Management Studio, click the plus sign to expand 
the server on which you wish to create the GIFTS database.

3 Right-click the Databases folder, and select New Database from the menu. 

4 In the Database name field, enter your database name of GIFTS. 

5 In the Owner field, enter the login that you created in Step 2a.
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6 In the database files table, specify the initial size of the database and its 

transaction log, and enter the expansion settings.

7 Go to the Options page.

8 In the Collation list, select SQL_Latin1_GENERAL_CP1_CI_AS.

Important: Before continuing, record the specifics of the GIFTS database 
and store this information in a safe place. You may need this information 
to recreate the system in case of a server failure.

9 Click OK. The database is created.

Please continue to the next section to install GIFTS on your network file 
server.
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Step 3: Installing GIFTS on Your File Server

In a network environment, program files and report template files for 
GIFTS must be installed on the file server first. This part of the installation is 
called the Server Installation, and is only run once.

Important: The workstation at which you perform the server installation is set 
up as a GIFTS workstation during the installation process. Perform this 
procedure from a workstation that you intend to use with GIFTS.

After installing the GIFTS software on your server, you need to create an 
ODBC data source for the workstation and to configure Windows to allow 
correspondence templates to work. Instructions for these two tasks follow 
the network server installation instructions.

Step 3a: Copying the GIFTS Configuration File

This procedure describes how to copy the configuration file from your 
GIFTS zip download to your computer. This file must be available during 
the installation process.

1 Copy the gifts.cfg file to a convenient location on your hard drive. Make 
a note of this location: you will need to know it when you install GIFTS.

2 Right-click on your new copy of the gifts.cfg file and select Properties.

3 On the General tab of the properties window, clear the check box for the 
Read-only option. (If the Read-only option is already off, you do not need 
to make any changes.)

4 Click OK to save the gifts.cfg properties.

Please proceed to the next step to install the GIFTS server software.
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Step 3b: Installing GIFTS on the File Server

Before You Begin: To avoid software conflicts, close all other applications on the 
workstation before you proceed.

1 Access the Install subfolder in the extracted GIFTS installation files and 
runt the Setup.exe file. The GIFTS Welcome screen is displayed.

Note: If the GIFTS Welcome screen is not displayed, run the Setup.exe file 
located in the Install folder of the Installation Disc.

Throughout the installation, you can click the Next button to continue, 
the Back button to return to the previous screen, or the Cancel button to 
cancel the installation.

2 Click Next. The Select Setup Type window opens.

3 Select the “Network Installation” option and click Next. The Choose 
Destination Location window opens.

4 Click Browse and specify the location of the GIFTS directory. You should 
choose a network location that will be accessible to all the workstations 
that will run GIFTS.

Example: You want to install GIFTS on the P: drive of your network file 
server. Enter P:\GIFTS after clicking Browse. The GIFTS database, 
program files, and correspondence and report template files will be 
copied to that folder (the “GIFTS directory”). If prompted that folder does 
not exist, click Yes to create it.

5 After specifying the location of the GIFTS directory, click Next. The 
Configuration Disk window prompts you to specify the location of your 
GIFTS configuration file.

6 Click Browse and browse to the directory that contains your gifts.cfg file. 
Then, click OK. You are prompted to select the word processor you would 
like to use with GIFTS.

7 Select Microsoft Word, and click Next. You are prompted to choose where 
you want the GIFTS program icons to be displayed in the Windows Start 
menu.
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8 Click Next. The Start Copying Files window displays a summary of the 

installation options you chose. The Current Settings field should indicate 
that a “GIFTS Server Installation” is to take place in the folder you 
specified.

9 If the options are correct, click Next. The installation begins.

10 If your file server is not running a compatible version of the Microsoft Data 
Access Components (MDAC) software needed to run GIFTS, you are 
prompted to install it. Click OK and follow the on-screen instructions to 
complete the MDAC installation.

Note: After the MDAC installation, a message may inform you that your 
computer must be restarted to continue. Agree to the restart. After the 
computer has restarted, the setup program continues at step 10.

11 When the installation is complete, you are notified. Click Finish.

Step 3c: ODBC Data Source Creation

Please perform the following steps to create the ODBC Data Source the 
workstation needs to communicate with the GIFTS database.

Important: Step 3b must be performed at the same workstation from which 
you ran step 3a above.

During the Server Installation, the MDAC installation program installed the 
ODBC driver that GIFTS uses to connect to your Microsoft SQL Server. In 
this procedure, you will create an ODBC Data Source named GIFTS, which 
GIFTS uses to connect to the GIFTS database. Please note that the user 
interface of the ODBC Administrator may vary.

1 In the Administrative Tools folder of the Windows Control Panel, double-
click the “Data Sources (ODBC)” icon to open the ODBC Data Source 
Administrator.

2 On the System DSN tab, click Add. The Create New Data Source window 
is displayed.

3 From the list of drivers, choose SQL Server and click Finish. The ODBC 
SQL Server Setup window is displayed.
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4 In the Name field, enter GIFTS.

5 Using the Server list, identify your SQL server. Click Next.

6 If there are options for specifying how SQL Server should verify the 
authenticity of the database login, select the option to verify using a login 
ID and password entered by the user.

7 Enter the server’s login ID and password that 
you created in Step 2, and click Next.

8 If your version of the ODBC Administrator includes an option to “Use 
regional settings when outputting currency, numbers, dates, and times,” 
ensure that this setting is turned off. Note that your version of the ODBC 
Administrator may not have this option. Otherwise, use default settings.

9 Click Finish to close the ODBC Administrator. You now have an ODBC 
Data Source.

Step 3d: Microsoft Windows Configuration

If you are going to use GIFTS to create merged correspondence in Microsoft 
Word, please use the following procedure to set up Microsoft Windows so 
that GIFTS and Word can share data properly:

1 Open the Windows Explorer.

2 From the Explorer menu, choose Tools ➤ Folder Options, View ➤ Folder 
Options, or View ➤ Options (the name of the menu item is different for 
different versions of Windows).

Note: In Microsoft Vista/7/8, from the Explorer menu, choose Organize 
➤ Folder and Search Options.

3 Go to the View tab (if applicable).

4 Ensure that the “Hide file extensions for known file types” or “Hide MS-
DOS file extensions for types that are registered” check box is not selected. 
Use of this option can interfere with the way in which Microsoft Word 
merges data from GIFTS.
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Tip: After installing GIFTS on any workstations running Windows Vista/7/
8, and before logging into GIFTS, you should give the workstation user full 
permissions to the gifts.ini file in the C:\WINDOWS directory. If you do not 
do this and log into GIFTS, the updated gifts.ini file is stored in the following 
location: C:\Users\[user name]\AppData\Local\VirtualStore \Windows. 
If you need to make any changes to the gifts.ini file, do so from this location.

When you are finished with all three steps of the workstation installation, 
you can proceed to “Step 4: Populating the GIFTS Database” below.
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Step 4: Populating the GIFTS Database

This process creates the SQL Server tables and system-defined data for a 
new GIFTS system. It must be run from the same workstation that you used 
in Steps 3a and 3b.

To populate the database:

1 Insert the MicroEdge GIFTS Installation Disc in the CD/DVD drive of the 
workstation.

2 Run the SQLINST.EXE program located in the Util directory of the 
Installation Disc. The Create SQL Database window opens.

3 Select the Create Source Database on Target Server option, then select 
the Copy Source Data to Target Server option.

The Source should be displayed as the location of the GIFTS.MDB file 
installed on the network server by Step 3a. 

Example: P:\GIFTS\GIFTS.MDB

This is a Microsoft Access version of the database; this process copies the 
database definitions to the GIFTS database on your SQL Server.

4 In the Target area, confirm that Database reads GIFTS and that the Data 
Source shows the network path to the database file. The Target area also 
displays the Login ID and Password for the GIFTS database.

5 Click OK to begin. A process monitor displays progress information. Save 
the process report for future reference; you may need it later.

The installation of your database is complete, and you are ready to set up 
your remaining workstations to use GIFTS.
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Step 5: Installing the GIFTS Workstations

This step consists of running the GIFTS Workstation Installations and 
setting up the appropriate ODBC data source on each workstation. 

Important: The GIFTS Workstation Installation must be run on every 
remaining workstation that is to have access to GIFTS.

Remember that the workstation used in “Step 3: Installing GIFTS on Your 
File Server” is already set up as a GIFTS workstation. To install GIFTS on 
your other workstations, you must complete the following procedures at 
each workstation:

❖ Run the GIFTS Workstation Installation.

❖ Set up the ODBC data source on the workstation.

❖ Ensure that Microsoft Windows is configured to work with the GIFTS 
Correspondence option.

Step 5a: Installing GIFTS

This process uses the GIFTS Setup program to install the files needed to run 
GIFTS from the workstation. The Server Installation installed the Setup 
program on the network; be sure to run your workstation installations from the 
network, not from your MicroEdge GIFTS Installation Disc.

1 Run the Setup.exe file located within the GIFTS\Setup directory on your 
file server.

Example: If you designated P:\GIFTS as your GIFTS directory, the Setup.exe 
file is located at P:\GIFTS\Setup\Setup.exe.

The GIFTS Welcome screen is displayed.

2 Click Next. The Select Program Folder window opens.

3 In the Select Program Folder window, choose where you want the GIFTS 
program icons to be displayed in the Windows Start menu, then click Next. 
The Start Copying Files window opens.
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4 Read the summary provided of the installation options you chose. The 

Current Settings field should indicate that a “GIFTS Workstation 
Installation” is to take place in the folder you specified.

If the options are correct, click Next. The installation begins.

5 If the workstation is not running a compatible version of the Microsoft 
Data Access Components (MDAC) software needed to run GIFTS, you 
are prompted to install it. Click OK and follow the on-screen instructions 
to complete the MDAC installation.

Note: After the MDAC installation, a message may inform you that your 
computer must be restarted to continue. Agree to the restart. After the 
computer has restarted, the setup program continues at step 6.

6 When the installation is complete, you are notified. Click Finish.

Step 5b: ODBC Data Source Creation

During the Step 5a, the MDAC installation program installed the ODBC 
driver that GIFTS uses to connect to your Microsoft SQL Server. In this 
procedure, you will create an ODBC Data Source named GIFTS. This data 
source is used by GIFTS to connect to the GIFTS database. Please note that 
the user interface of the ODBC Administrator may vary.

1 In the Administrative Tools folder of the Windows Control Panel, double-
click the “Data Sources (ODBC)” icon to open the ODBC Data Source 
Administrator.

2 On the System DSN tab, click Add. The Create New Data Source window 
is displayed.

3 From the list of drivers, choose SQL Server and click Finish. The ODBC 
SQL Server Setup window is displayed.

4 In the Name field, enter GIFTS.

5 Using the Server list, identify your SQL server. Click Next.

6 If there are options for specifying how SQL Server should verify the 
authenticity of the database login, select the option to verify using a login 
ID and password entered by the user.
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7 Enter the server’s login ID and password that 

you created in Step 2, and click Next.

8 If your version of the ODBC Administrator includes an option to “Use 
regional settings when outputting currency, numbers, dates, and times,” 
ensure that this setting is turned off. Note that your version of the ODBC 
Administrator may not have this option. Otherwise, use the default 
settings.

9 Click Finish to close the ODBC Administrator. You now have an ODBC 
Data Source named GIFTS.

Step 5c: Microsoft Windows Configuration

If you are going to use GIFTS to create merged correspondence in Microsoft 
Word, please use the following procedure to set up Microsoft Windows so 
that GIFTS and Word can share data properly:

1 Open the Windows Explorer.

2 From the Explorer menu, choose Tools ➤ Folder Options, View ➤ Folder 
Options, or View ➤ Options (the name of the menu item is different for 
different versions of Windows).

Note: In Microsoft Vista, from the Explorer menu, choose Organize ➤ 
Folder and Search Options.

3 Go to the View tab (if applicable).

4 Ensure that the “Hide file extensions for known file types” or “Hide MS-
DOS file extensions for types that are registered” check box is not selected. 
Use of this option can interfere with the way in which Microsoft Word 
merges data from GIFTS.

When you have installed GIFTS, created an ODBC Data Source, and 
configured Windows properly on each workstation, your GIFTS installation 
should be complete. Remember that to use GIFTS, users must have full 
access rights to the GIFTS directory on your file server.
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Step 6: Logging in to GIFTS for the First Time

To ensure that your installation has been successful, you can log in to a 
GIFTS workstation by entering Admin as the Login ID. No password is 
required.

Important: The Admin login allows full access to all areas of the GIFTS 
system; be sure to set up Login IDs and passwords when you set up GIFTS 
for your organization, as described in the GIFTS Administrator’s Guide.
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Before You Begin

The following important points should be addressed before you install 
GIFTS:

❖ Please read this entire chapter carefully. You should understand the entire 
installation process before you begin.

❖ If Crystal Reports is installed on any computer on which you plan to install 
GIFTS, please see “Compatibility with Crystal Reports” on page 164.

❖ The installation process creates several network directories. Make sure 
that you have the necessary permissions to create these directories.

❖ GIFTS uses Microsoft Word to produce correspondence and write-ups. 
Please make sure that a compatible version of Microsoft Word has been 
correctly installed and is currently functioning without errors.

❖ If you use virus-protection software, please make sure that it is disabled 
before attempting to run the installation. An active virus-protection 
program may cause errors during the installation process.

The above points are vital towards insuring that your installation is 
successful. Please make sure that each issue has been thoroughly addressed 
before continuing.

System Files

For a complete list of the system files installed by the GIFTS setup process, 
consult the “Installation Impact Analysis” on page 149.
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How to Obtain Technical Support

If you have any problems during your installation, please contact MicroEdge 
Technical Support.

❖ by submitting a New Case request through PowerME. Go to 
http://www.microedge.com and log in to the PowerME website.

❖ by email at helpdesk@microedge.com

❖ by phone at (877) 704-3343

❖ by fax at (212) 757-1784
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Overview of the Installation Process

The procedures outlined below will take you through the entire process of 
installing the GIFTS client/server edition for Oracle server. The installation 
consists of the following major steps; each step corresponds to a section in 
this chapter.

Step 1: Important Prerequisites In this step, you are asked to verify that you 
have the appropriate staff necessary for the installation process, and that 
your Oracle server has been configured correctly to accommodate the 
GIFTS system. It also outlines prerequisites for your network environment.

Step 2: Setting Up the GIFTS Database This portion of the installation is 
used to create the GIFTS database on the Oracle server. This requires the 
services of a trained Oracle Database Administrator who is familiar with all 
aspects of setting up and administering the Oracle server environment.

Step 3: Installing GIFTS on Your File Server In this step, you will install 
GIFTS onto a network drive that is accessible to all workstations that will 
use GIFTS. This step also includes the configuration of a single workstation, 
which is necessary for Step 4.

Step 4: Populating the GIFTS Database This step creates the table definitions 
for the GIFTS database on the Oracle server, and populates that database 
with system-defined data necessary to the operation of the GIFTS system.

Step 5: Installing the GIFTS Workstations This step configures your other 
workstations to run GIFTS. (The workstation on which you performed Step 
3 is already configured to be a GIFTS workstation.)

Step 6: Logging in to GIFTS for the First Time This step describes how to log 
in to GIFTS, verifying that your installation has been successful.
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Step 1: Important Prerequisites

The following prerequisites must be met before you begin your GIFTS 
installation. Please note that MicroEdge Technical Support staff will only be 
able to assist you in troubleshooting your installation once all of these 
prerequisites have been met.

MicroEdge Technical Support staff can only assist you in matters related 
exclusively to the installation of GIFTS software. For matters relating to 
your hardware, network, and the installation of the Oracle server, please 
consult with the appropriate vendors.

Prerequisites for the Oracle Environment

Please attend to the following before beginning your installation:

✔ Make sure you have access to the services of a trained Oracle Database 
Administrator familiar with all aspects of setting up and administering the 
Oracle environment. Please note that MicroEdge Technical Support 
personnel cannot provide advice or assistance related to the setup of your 
Oracle software and/or hardware.

✔ Ensure that Oracle server is properly installed, and ensure that all client 
workstations can connect to it using SQL Plus.

✔ GIFTS requires ODBC drivers on each workstation to connect to the 
Oracle server. These drivers are installed by the GIFTS Setup program. 
Refer to the GIFTS 6.6 and GCS 3.6 Compatibility Fact Sheet on the GIFTS 
PowerME webpage at http://www.microedge.com for a list of compatible 
drivers.

To check the version of the ODBC drivers installed on a workstation, you 
can use the “Data Sources (ODBC)” Control Panel.
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Prerequisites for Your Network Environment

Please attend to the following before beginning your installation:

✔ Make sure you have access to an in-house network administrator, or a 
consultant familiar with your network environment, who has full network 
administrative access rights.

✔ The user installing the system must have the permissions needed to create 
a directory on the target drive where the GIFTS file server will be installed.

✔ Ensure that all computers you plan to use with GIFTS have adequate 
storage space and hardware, as described in “GIFTS Storage 
Requirements” on page 7 and “Hardware Configuration Guidelines” on 
page 12.

Once you have verified that these prerequisites have been met, you may 
proceed to “Step 2: Setting Up the GIFTS Database” below. 
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Step 2: Setting Up the GIFTS Database

This step of the installation involves creating a new database on the Oracle 
server for GIFTS. This process requires the services of a trained Oracle 
Database Administrator familiar with all aspects of setting up and 
administering the Oracle environment.

Step 2a: Create the Database

The GIFTS database must be defined with an appropriate size to 
accommodate the growth of the system by normal data entry, as well as any 
data that may be imported into your system from another source. In 
general, you should allocate about 20 MB for each 1,000 grant requests in 
your database.

Example: If your organization processes 1,000 grant requests per year, and you 
have five years of historical data, you should allocate approximately 200 MB 
for your database device (100 MB for your historical data and 100 MB for the 
next five years).

In order to run GIFTS, we recommend that you create your GIFTS database 
with the following Character Set option:

❖ Character Set option = WE8ISO8859P1

❖ Sort Order option = binary

If you choose a different character set, make sure to choose one that is a 
superset of the recommended set. (If you use a character set that does not 
include all characters the GIFTS database is programmed to use, your 
GIFTS system may not work properly.) You can also use a different sort 
order.

Important: The character set and sort order recommended above are the only 
ones with which GIFTS has been tested and certified. We will support 
GIFTS when used with other character sets and sort orders. However, be 
aware that if your choices create issues in your GIFTS system, the only 
solution our support staff may be able to offer is to change to the 
recommended settings.
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Note: The following steps are for Oracle Server 10g. The process in other 
versions may differ.

To create your GIFTS database:

1 Launch the Database Configuration Assistant. The Welcome screen 
opens.

2 Click Next. On the next page, select Create a Database and click Next.

3 Select General Purpose and click Next.

4 In the Global Database Name field, enter GIFTS. The SID field is 
automatically populated with GIFTS. Click Next.

5 On the Management Options page, click Next.

6 Enter the password for the default user accounts in both the Password and 
Confirm Password fields, then click Next.

7 Specify the desired Storage Options, then click Next.

8 Specify the desired Database File Locations, then click Next.

9 Specify the desired Recovery Configuration, then click Next, and then 
Next again.

10 Specify the desired Initialization Parameters (as discussed above), then 
click Next.

11 Specify the desired Database Storage parameters, then click Next.

12 Click Finish, then OK. The GIFTS database is created.

Step 2b: Create the GIFTS Login

A login user must be created for GIFTS in order for GIFTS to successfully 
connect to the database. Initially, you must use the default login ID and 
password.

Note: If you want to change the password, you may do so after you install 
GIFTS. Note that when you change the password on the server, you must 
also update the database login information in the GIFTS.SYS or gifts.ini file. 
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For details on updating the Client/Server login ID and password in GIFTS, 
please refer to the GIFTS Administrator's Guide.

The name and location of this utility will vary for other versions of Oracle. 
Note that the instructions below are for Oracle 10g.

To create the GIFTS login:

1 Log in to the Oracle Enterprise Manager Console.

2 Click I agree.

3 From the Administration tab, click Users in the Users & Privileges section. 

4 Click Create.

5 In the General tab, enter your chosen login ID in the 
Name field, and the password in the Enter Password and Confirm 
Password fields.

6 In the same window, move to the Roles tab, click Edit List, and select DBA.

7 Click > to move DBA to the Selected Roles column, then click OK. 

8 Select the Connect and DBA Admin Options, then click OK.

9 Specify any other desired login parameters, and click OK. The login is 
created.
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Step 3: Installing GIFTS on Your File Server

In a network environment, the GIFTS program files and templates must be 
installed on the file server first. This part of the installation is called the 
Server Installation, and is only run once.

Important: The workstation at which you perform the server installation is set 
up as a GIFTS workstation during the installation process. Perform this 
procedure from a workstation that you intend to use with GIFTS.

After you install the GIFTS software on your file server, three more steps 
must be performed to complete network installation and the configuration 
of this GIFTS workstation: Oracle service creation, ODBC data source 
creation, and configuring Microsoft Windows. Instructions for these three 
tasks follow the network server installation instructions below.

Step 3a: Copying the GIFTS Configuration File

This procedure describes how to copy the configuration file for your GIFTS 
system to your computer. This file must be available during the installation 
process.

1 Copy the gifts.cfg file to a convenient location on your hard drive. Make 
a note of this location: you will need to know it when you install GIFTS.

2 Right-click on your new copy of the gifts.cfg file and select Properties.

3 On the General tab of the properties window, clear the check box for the 
Read-only option. (If the Read-only option is already off, you do not need 
to make any changes.)

4 Click OK to save the gifts.cfg properties.

Please proceed to the next step to install the GIFTS server software.
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Step 3b: Installing GIFTS on the File Server

Before You Begin: To avoid software conflicts, close all other applications on the 
workstation before you proceed.

1 Access the Install subfolder of the extracted GIFTS installation files and 
run the Setup.exe file. The GIFTS Welcome screen is displayed.

Note: If the GIFTS Welcome screen is not displayed, run the Setup.exe file 
located in the Install folder of the Installation Disc.

Throughout the installation, you can click Next to continue, Back to return 
to the previous screen, or Cancel to cancel the installation.

2 Click Next. The Select Setup Type window opens.

3 Select the “Network Installation” option and click Next. The Choose 
Destination Location window opens.

4 Click Browse and specify the location of the GIFTS directory. You should 
choose a network location that will be accessible to all the workstations 
that will run GIFTS.

Example: You want to install GIFTS on the P: drive of your network file 
server. Enter P:\GIFTS after clicking Browse. The GIFTS database, 
program files, and correspondence and report template files will be 
copied to that folder (the “GIFTS directory”). If prompted that folder does 
not exist, click Yes to create it.

5 After specifying the location of the GIFTS directory, click Next. The 
Configuration Disk window prompts you to specify the location of your 
GIFTS configuration file.

6 Click Browse and browse to the directory that contains your gifts.cfg file. 
Then, click OK. You are prompted to select the word processor you would 
like to use with GIFTS.

7 Select Microsoft Word, and click Next. You are prompted to choose where 
you want the GIFTS program icons to be displayed in the Windows Start 
menu.

8 Click Next. The Start Copying Files window displays a summary of the 
installation options you chose. The Current Settings field should indicate 
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that a “GIFTS Server Installation” is to take place in the folder you 
specified.

9 If the options are correct, click Next. The installation begins.

10 If your file server is not running a compatible version of the Microsoft Data 
Access Components (MDAC) software needed to run GIFTS, you are 
prompted to install it. Click OK and follow the on-screen instructions to 
complete the MDAC installation.

Note: After the MDAC installation, a message may inform you that your 
computer must be restarted to continue. Agree to the restart. After the 
computer has restarted, the setup program continues at step 10.

11 When the installation is complete, you are notified. Click Finish.

Step 3c: Oracle Service Creation

To establish Oracle Service for this GIFTS workstation:

1 Open the Oracle Net Configuration Assistant.

2 In the Welcome screen, select the “Local Net Service Name 
configuration” option and click Next. The Net Service Name 
Configuration window opens.

3 Select the “Add” option and click Next. The Net Service Name 
Configuration, Database Version window opens.

4 In the Service Name field, enter the desired name (usually the database 
name). Click Next. The Net Service Name Configuration, Select Protocols 
window opens.

5 From the list, select the protocol for your network (contact your network 
administrator if you are unsure). Click Next. The Net Service Name 
Configuration, [Selected Protocol] window opens.

6 Enter the Host name and select the port number (use either the standard 
port number, or enter another one). Click Next. The Net Service Name 
Configuration, Test window opens.

7 Here, you may choose to test the service before continuing:
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❖ If you choose “No, do not test,” click Next and skip to step 11.

❖ If you choose “Yes, perform a test,” click Next and proceed to step 9.

8 After clicking Next, the test will either succeed or fail:

❖ If the test is a success, please skip to step 11.

❖ If the test fails, proceed to step 10.

9 Click the Change Login button. Enter the user name and the 
password, then click OK. The test will run again: ❖ If the 

test is a success, click Next and proceed to step 11.

❖ If the test fails, contact your network administrator.

10 In the Net Service Name Configuration, Net Service Name window, enter 
the service name and click Next.

You are asked if you want to configure another net service name. Select 
No and click Next. The net service name configuration is complete.

Step 3d: ODBC Data Source Creation

In this step, you will create an ODBC Data Source named GIFTS. This data 
source is used by the Crystal Reports viewer included with GIFTS to 
connect to the GIFTS database on your Oracle server. GIFTS and GIFTS 
Connections use a different ODBC driver to connect to the database, but use 
the DSN information in this data source to locate your database.

Note: To complete this step, the Oracle ODBC drivers listed on the 
Compatibility Fact Sheet for your version of GIFTS must reside on the 
workstation. In most cases (as described in the fact sheet), these drivers were 
installed by the GIFTS Setup program.

To set up the workstation’s data source:

1 In the Administrative Tools folder of the Windows Control Panel, double-
click the “Data Sources (ODBC)” icon to open the ODBC Data Source 
Administrator.

2 On the System DSN tab, click Add. The Create New Data Source window 
is displayed.
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3 From the list of ODBC drivers, choose CR Oracle ODBC Driver 5.0 and click 

Finish. The ODBC Oracle Driver Setup window is displayed.

4 In the Data Source Name field, enter GIFTS.

5 In the Server Name field, enter the name of the database server you are 
using with GIFTS.

6 Click OK and close the ODBC Administrator. You now have an ODBC 
Data Source named GIFTS.

Step 3e: Microsoft Windows Configuration

If you are going to use GIFTS to create merged correspondence in Microsoft 
Word, please use the following procedure to set up Microsoft Windows so 
that GIFTS and Word can share data properly:

1 Open the Windows Explorer.

2 From the Explorer menu, choose Tools ➤ Folder Options, View ➤ Folder 
Options, or View ➤ Options (the name of the menu item is different for 
different versions of Windows).

Note: In Microsoft Vista, from the Explorer menu, choose Organize ➤ 
Folder and Search Options.

3 Go to the View tab (if applicable).

4 Ensure that the “Hide file extensions for known file types” or “Hide MS-
DOS file extensions for types that are registered” check box is not selected. 
Use of this option can interfere with the way in which Microsoft Word 
merges data from GIFTS.

Tip: After installing GIFTS on any workstations running Windows Vista, and 
before logging into GIFTS, you should give the workstation user full 
permissions to the gifts.ini file in the C:\WINDOWS directory. If you do 
not do this and log into GIFTS, the updated gifts.ini file is stored in the 
following location: C:\Users\[user name]\AppData\Local\VirtualStore 
\Windows. If you need to make any changes to the gifts.ini file, do so from 
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this location. This is only necessary for workstations running Windows 
Vista. 

When you are finished with all three workstation installation tasks, you can 
proceed to the following section.
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Step 4: Populating the GIFTS Database

This process creates the tables and system data for a new GIFTS system. It 
must be run from a workstation that is already set up to run the client/
server version of GIFTS.

Before You Begin: This process uses default parameters (like segment size) in the 
SQL Scripts it uses to create the database on your Oracle server. Your 
Database Administrator may wish to review these SQL Scripts and, if 
necessary, modify some of these parameters to improve performance. For 
more information, please refer to “Retrieving the Database Creation Scripts” 
on page 78.

1 Run the SQLINST.EXE program located in the Util directory of the 
Installation Disc.

2 Select the “Create Source Database on Target Server” option, then select 
the “Copy Source Data to Target Server” option.

The Source area should display the location of the GIFTS.MDB database 
file installed on the network server by Step 3a of the installation process.

Example: P:\GIFTS\GIFTS.MDB

This is a Microsoft Access version of the database; this process copies the 
database definitions to the GIFTS database on your Oracle server.

3 In the Target area, confirm that Database reads GIFTS and that Data Source 
shows the network path to the database file. The Target area also displays 
the Login ID and Password for the GIFTS database.

4 Click OK to begin. A process monitor displays progress information. Save 
the process report for future reference; you may need it later.

The installation of your database is complete, and you are ready to set up 
your workstations to use GIFTS.
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Step 5: Installing the GIFTS Workstations

This step consists of running the GIFTS Workstation Installation, creating 
Oracle service to the workstation, setting up the appropriate ODBC data 
source, and configuring Windows to use correspondence templates 
correctly. The Workstation Installation must be run on every remaining 
workstation that is to have access to GIFTS.

Important: To use GIFTS, all users must have full network access rights to the 
GIFTS directory on your file server.

Note: The GIFTS workstation from which you performed “Step 3: Installing 
GIFTS on Your File Server” is already configured as a GIFTS 6.6 workstation.

Step 5a: Perform the Workstation Installation

This process uses the GIFTS Setup program to install the files needed to run 
GIFTS from this workstation. The Server Installation installed the Setup 
program on the network; be sure to run your workstation installations from the 
network, not from the Installation Disc.

1 Run the Setup.exe file located within the GIFTS\Setup directory on your 
file server.

Example: If you designated P:\GIFTS as your GIFTS directory, the Setup.exe 
file is located at P:\GIFTS\Setup\Setup.exe.

The GIFTS Welcome screen is displayed.

2 Click Next. The Select Program Folder window opens.

3 In the Select Program Folder window, choose where you want the GIFTS 
program icons to be displayed in the Windows Start menu, then click 
Next. The Start Copying Files window opens.

4 Read the summary provided of the installation options you chose. The 
Current Settings field should indicate that a “GIFTS Workstation 
Installation” is to take place in the folder you specified.

If the options are correct, click Next. The installation begins.
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5 If your workstation is not running a compatible version of the Microsoft 

Data Access Components (MDAC) software needed to run GIFTS, you 
are prompted to install it. Click OK and follow the on-screen instructions 
to complete the MDAC installation.

Note: After the MDAC installation, a message may inform you that your 
computer must be restarted to continue. Agree to the restart. After the 
computer has restarted, the setup program continues at step 6.

6 When the installation is complete, you are notified. Click Finish.

Step 5b: Oracle Service Creation

To establish Oracle Service for this GIFTS workstation:

1 Open the Oracle Net Configuration Assistant.

2 In the Welcome screen, select the “Local Net Service Name 
configuration” option and click Next. The Net Service Name 
Configuration window opens.

3 Select the “Add” option and click Next. The Net Service Name 
Configuration, Database Version window opens.

4 Select the “Oracle 8i or later database or service” option and click Next. 
The Net Service Name Configuration, Service Name window opens.

5 In the Service Name field, enter the desired name (usually the database 
name). Click Next. The Net Service Name Configuration, Select Protocols 
window opens.

6 From the list, select the protocol for your network (contact your network 
administrator if you are unsure). Click Next. The Net Service Name 
Configuration, [Selected Protocol] window opens.

7 Enter the host name and select the port number (use either the standard 
port number, or enter another one). Click Next. The Net Service Name 
Configuration, Test window opens.

8 Here, you may choose to test the service before continuing:

❖ If you choose “No, do not test,” click Next and skip to step 11.
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❖ If you choose “Yes, perform a test,” click Next and proceed to step 9.

9 After clicking Next, the test will either succeed or fail:

❖ If the test is a success, please skip to step 11.

❖ If the test fails, proceed to step 10.

10 Click the Change Login button. Enter the user name and the 
password, then click OK. The test will run again:

❖ If the test is a success, click Next and proceed to step 11.

❖ If the test fails, contact your network administrator.

11 In the Net Service Name Configuration, Net Service Name window, enter 
the service name and click Next.

You are asked if you want to configure another net service name. Select 
No and click Next. The net service name configuration is complete.

Step 5c: ODBC Data Source Creation

In this step, you will create an ODBC Data Source named GIFTS. This data 
source is used by the Crystal Reports viewer included with GIFTS to 
connect to the GIFTS database on your Oracle server. GIFTS and GIFTS 
Connections use a different ODBC driver to connect to the database, but use 
the DSN information in this data source to locate your database.

Note: To complete this step, the Oracle ODBC drivers listed on the 
Compatibility Fact Sheet for your version of GIFTS must reside on the 
workstation. In most cases (as described in the fact sheet), these drivers were 
installed when you installed GIFTS.

To create the data source:

1 In the Administrative Tools folder of the Windows Control Panel, double-
click the “Data Sources (ODBC)” icon to open the ODBC Data Source 
Administrator.

2 On the System DSN tab, click Add. The Create New Data Source window 
is displayed.
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3 From the list of ODBC drivers, choose CR Oracle ODBC Driver 5.0 and click 

Finish. The ODBC Oracle Driver Setup window is displayed.

4 In the Data Source Name field, enter GIFTS.

5 In the Server Name field, enter the name of the database server you are 
using with GIFTS.

6 Click OK and close the ODBC Administrator. You now have an ODBC 
Data Source named GIFTS.

Step 5d: Microsoft Windows Configuration

If you are going to use GIFTS to create merged correspondence in Microsoft 
Word, please use the following procedure to set up Microsoft Windows so 
that GIFTS and Word can share data properly:

1 Open the Windows Explorer.

2 From the Explorer menu, choose Tools ➤ Folder Options, View ➤ Folder 
Options, or View ➤ Options (the name of the menu item is different for 
different versions of Windows).

Note: In Microsoft Vista, from the Explorer menu, choose Organize ➤ 
Folder and Search Options.

3 Go to the View tab (if applicable).

4 Ensure that the “Hide file extensions for known file types” or “Hide MS-
DOS file extensions for types that are registered” check box is not selected. 
Use of this option can interfere with the way in which Microsoft Word 
merges data from GIFTS.

When you are finished with all three workstation installation tasks, your 
GIFTS installation should be complete. Remember that to use GIFTS, all 
users must have full access rights to the GIFTS directory on your file server.
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Step 6: Logging in to GIFTS for the First Time

To ensure that your installation has been successful, you can log in to a 
GIFTS workstation by entering Admin as the Login ID. No password is 
required.

Important: The Admin login allows full access to all areas of the GIFTS 
system; be sure to set up Login IDs and passwords when you set up GIFTS 
for your organization, as described in the GIFTS Administrator’s Guide.
Step 6: Logging in to GIFTS for the First Time 77



New Oracle Server Installation4

Retrieving the Database Creation Scripts

Important: The information in this section applies only to users who wish to 
review or modify the scripts used by the SQLINST.EXE utility to populate 
the Oracle database (as described in “Step 4: Populating the GIFTS 
Database” on page 72).

To save the SQL Scripts used by the SQLINST.EXE utility as a text file:

1 Insert the MicroEdge GIFTS Installation Disc in the CD/DVD drive of 
your workstation. 

2 Run the SQLINST.EXE program located in the Util directory of the 
Installation Disc.

3 Check the Create SQL Scripts option and choose where you wish the 
scripts to be saved.

4 Ensure that the “Create Source Database on Target Server” and “Copy 
Source Data to Target Server” options are not selected.

5 Click OK. The scripts are displayed and saved to the file you specified.

Important: When you create the database tables, ensure that you are logged 
in as the default user. If you do not, processes that identify the tables by 
their owner as well as their name—including the loading of converted data 
and the running of all GIFTS reports—will fail.
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Before You Begin

The following important points should be addressed before you install GIFTS:

❖ Please make sure to read these instructions carefully. You should 
understand the entire installation process before you begin.

❖ Please make sure you have access to the services of a trained network 
administrator familiar with all aspects of setting up and administering the 
Microsoft Terminal Server and Citrix Presentation Server environments. 
MicroEdge Technical Support personnel cannot provide advice or 
assistance related to the setup of Terminal Server and Citrix.

❖ Ensure that your server operating system and Citrix software are 
compatible with GIFTS. To obtain the latest compatibility information for 
GIFTS, please go to http://www.microedge.com and log in to GIFTS 
PowerME.

The above points are vital towards ensuring that your installation is 
successful. Please make sure that each issue has been thoroughly addressed 
before continuing.
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Citrix Installation Options

The instructions in this chapter describe two possible installation scenarios 
for using GIFTS with Citrix Presentation Server: 

❖ Installing GIFTS Workstation Software on Your Citrix Server – this 
procedure describes how to install the GIFTS workstation software on a 
computer running Terminal Services with Citrix. This procedure may be 
used by clients with file server or client/server configurations of GIFTS, 
including clients who have already installed their GIFTS system on other 
computers. See “Option 1: Installing a GIFTS Workstation on Your 
Server” on page 82.

❖ Installing a Standalone GIFTS System on Your Citrix Server – this 
option is for clients who wish to install their entire GIFTS system on a 
single computer running Terminal Services with Citrix, and to make 
GIFTS available to other users through Citrix Presentation Server. See 
“Option 2: Installing a Standalone System on Your Server” on page 86.

To inquire about other possible options for installing GIFTS with Citrix, 
please contact MicroEdge Technical Support.
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Option 1: Installing a GIFTS Workstation 
on Your Server

This procedure describes how to install the GIFTS workstation software on 
a computer running Windows Terminal Services to provide access to 
GIFTS through Citrix Presentation Server.

Step 1: Install Your GIFTS System

The first step is to install all parts of the GIFTS system except the 
workstation that you plan to use to provide access through Citrix 
Presentation Server. To install GIFTS, please follow the instructions for 
your system configuration:

❖ Clients with a file server system should refer to the instructions in “New 
GIFTS Standalone or File Server Installation” on page 21.

❖ Clients installing GIFTS in a SQL Server environment should follow the 
instructions in “New Microsoft SQL Server Installation” on page 35.

❖ Clients installing GIFTS in an Oracle server environment should follow 
the instructions in“New Oracle Server Installation” on page 57.

Note: If you wish to install GIFTS on a single computer only, please refer to 
“Option 2: Installing a Standalone System on Your Server” on page 86.

Step 2: Disabling Remote Logons

Note: MicroEdge does not provide support for Citrix Presentation Server or 
Microsoft Windows. The following steps are included as a guideline for 
performing steps necessary to the installation of GIFTS. The interface of 
Windows or Citrix may vary, as determined by the versions of the software 
that you are running.

Important: You must perform this step from the server console.
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In this procedure, you will disable remote logons to your Citrix Presentation 
Server, which is a prerequisite to installing the GIFTS workstation software 
on your Terminal Server:

1 Log on to the server as a member of the local Administrators group.

2 Use the Windows Start menu to open the Presentation Server Console: 
select All Programs ➤ Citrix ➤ Management Consoles ➤ Presentation 
Server Console.

3 Highlight the server in the server list.

4 Ensure that there are no remote sessions running.

5 Right-click the server name, and select Properties from the menu. The 
server’s properties are displayed.

6 In the left column, select Metaframe Settings.

7 In the right column, turn off the option to “Allow logons to this server.”

8 Click OK to save the server properties.

9 Close the Management Console.

You can now proceed to the next step to install the GIFTS workstation 
software on your Presentation Server.

Step 3: Installing GIFTS on Your Presentation Server

Before You Begin: Please review the following important information regarding 
the installation of GIFTS with Citrix:

❖ You must launch the GIFTS Setup program from within the Add/Remove 
Programs Control Panel, as described in this procedure. If you do not run 
GIFTS Setup from within the Control Panel, GIFTS will not run under 
Terminal Services.

❖ If you are prompted to restart the computer during the installation 
procedure, choose to restart later. You must complete the entire GIFTS 
installation process and close the Add/Remove Programs utility before 
restarting the computer.
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❖ At the conclusion of the GIFTS Setup process, you should close the Add/

Remove Programs utility before proceeding; make sure that the GIFTS 
installation is complete before closing the utility.

To install GIFTS on your server:

1 From the Windows Start menu, choose Control Panel ➤ Add or Remove 
Programs.

2 In the left column, click Add New Programs. The options for adding 
programs are displayed.

3 Click the CD or Floppy button.

4 Browse to and run the Setup program located in the GIFTS directory of 
your GIFTS file server.

Example: If you designated P:\GIFTS as your GIFTS directory, the Setup.exe 
file is located at P:\GIFTS\Setup\Setup.exe.

The GIFTS installation process begins.

5 You may now install GIFTS, as described in the section that applies to your 
configuration:

Important Reminder: You must run the GIFTS Setup program from within the 
Add/Remove Programs Control Panel.

❖ File server installations – please refer to “Workstation Installation” 
on page 31. 

❖ SQL Server installations – please refer to “Step 5: Installing the 
GIFTS Workstations” on page 52.

❖ Oracle Server installations – please refer to “Step 5: Installing the 
GIFTS Workstations” on page 73.

When you have finished installing the GIFTS workstation software 
(including the steps for configuring Microsoft Windows and, for client/
server systems, creating an ODBC data source), you may proceed to the 
next step.
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Step 4: Copying the GIFTS Help Files

This procedure describes how make the GIFTS help files available to users 
who access GIFTS through Citrix Presentation Server:

1 Using Windows Explorer, open the WINDOWS or WINNT folder of your 
Windows Terminal Server. For example:

M:\WINDOWS

2 Copy the following GIFTS help files:

3 Paste the GIFTS help files to the virtual WINDOWS or WINNT directory 
of each user who uses GIFTS through Citrix. The locations of these virtual 
directories follow this pattern:

M:\Documents and Settings\[User Name]\WINDOWS

(where [User Name] is the network name or login ID for each user)

The GIFTS help files are now available to your users. Please continue to the 
next step to complete your installation.

Step 5: Completing Your Installation

To complete your installation, publish GIFTS on your Presentation Server 
according to your organization’s policies and the instructions provided by 
Citrix. Then, just re-enable logons to your server and your installation of 
GIFTS with Citrix is complete! 

empadmin.chm gfwbudget.chm

empgifts.chm gfwgam.chm

gfw60.chm gifts.chm

gfwadmin.chm mesupp.chm

gfwap.chm ChartFX_98_GUI.hlp
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Option 2: Installing a Standalone System 
on Your Server

This procedure describes how to install a standalone GIFTS system on a 
computer running Citrix Presentation Server to provide access to GIFTS 
through Citrix. Using this procedure, all components of GIFTS will be 
installed on the computer—including the GIFTS database. This option is not 
intended for client/server systems.

Step 1: Disabling Remote Logons

Before installing GIFTS, you should disable remote logons to your Citrix 
Presentation Server. To do so, please follow the instructions in “Step 2: 
Disabling Remote Logons” on page 82 and proceed to the next step.

Step 2: Copying Your GIFTS Configuration File

This procedure describes how to copy the configuration file for your GIFTS 
system to your Terminal Server. This file must be available during the 
installation process.

1 Copy the gifts.cfg file to a convenient location on your local hard drive. 
Make a note of this location: you will need to know it when you install 
GIFTS.

2 Right-click on your new copy of the gifts.cfg file and select Properties.

3 On the General tab of the properties window, clear the check box for the 
Read-only option. (If the Read-only option is already off, you do not need 
to make any changes.)

4 Click OK to save the gifts.cfg properties.

Please proceed to the next step to install the GIFTS software.
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Step 3: Installing GIFTS

Before You Begin: Please review the following important information regarding 
the installation of GIFTS with Citrix:

❖ You must launch the GIFTS Setup program from within the Add/Remove 
Programs Control Panel, as described in this procedure. If you do not run 
GIFTS Setup from within the Control Panel, GIFTS will not run under 
Terminal Services.

❖ If you are prompted to restart the computer during the installation 
procedure, choose to restart later. You must complete the entire GIFTS 
installation process and close the Add/Remove Programs utility before 
restarting the computer.

❖ At the conclusion of the GIFTS Setup process, you should close the Add/
Remove Programs utility before proceeding; make sure that the GIFTS 
installation is complete before closing the utility.

To install a standalone GIFTS system on your Terminal Server:

1 From the Windows Start menu, choose Control Panel ➤ Add or Remove 
Programs.

2 In the left column, click Add New Programs. The options for adding 
programs are displayed.

3 Click the “CD or Floppy” button.

4 Insert your MicroEdge GIFTS Installation Disc.

5 Click Next. The GIFTS installation process begins.

Important Reminder: You must run the GIFTS Setup program from within the 
Add/Remove Programs Control Panel.

6 You may now continue with your GIFTS installation. To do so, please 
follow the steps in “New Standalone Installation” on page 24.

When you have finished installing GIFTS (including the steps for 
configuring Microsoft Windows), you may proceed to the next step.
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Step 4: Copying the GIFTS Help Files

To make the GIFTS online help available to each user, please follow the 
instructions in “Step 4: Copying the GIFTS Help Files” on page 85. Then, 
proceed to the next step of this procedure to complete your installation. 

Step 5: Completing Your Installation

To complete your installation, publish GIFTS on your Presentation Server 
according to your organization’s policies and the instructions provided by 
Citrix. Then, just re-enable logons to your server and your installation of 
GIFTS with Citrix is complete! 
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Before You Begin

This process upgrades your GIFTS 6.4 or 6.5 system to GIFTS 6.6. To 
determine which version of GIFTS you have, choose Help > About from the 
menu of any Windows-based GIFTS program.

!
Caution: If you have a version of GIFTS earlier than GIFTS 6.4, please contact 
MicroEdge Technical Support. If you attempt to upgrade an earlier GIFTS 
system, your database upgrade will fail and you will have to restore your 
backup of the GIFTS system.

The following important points should be addressed before you upgrade 
GIFTS:

❖ Your GIFTS program files, database, reports, and template files are altered 
by this process. Please make a complete backup of your current GIFTS 
directory (including your database) before proceeding.

❖ All users must be logged out of GIFTS for the duration of your upgrade.

❖ Upgrading GIFTS can take a significant amount of time. If you use 
MyGIFTS or ReviewerCONNECT, you will have to upgrade to GIFTS 
Connections at the conclusion of your GIFTS upgrade. Please review the 
GIFTS Connections: MyGIFTS and ReviewerCONNECT Installation and 
Technical Reference Guide and consider your upgrade of GCS when planning 
the time and resources needed to complete your upgrade.

❖ If you are using any virus-protection software, please disable it before you 
upgrade GIFTS. Virus-protection programs may cause errors during the 
upgrade process.

❖ If Crystal Reports is installed on your system, be sure to read 
“Compatibility with Crystal Reports” on page 164.

❖ Read the following sections, “About the Standalone Upgrade” and “About 
the File Server Upgrade”, to determine which type of upgrade you need 
to perform.
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The points above are vital to ensuring that your upgrade is successful. Please 
make sure that each issue has been thoroughly addressed before continuing.

About the Standalone Upgrade

This type of upgrade is for clients who have a single-user version of GIFTS 
or Essential GIFTS installed on a single workstation. To perform this type of 
upgrade, please refer to “Standalone Upgrade” on page 93.

About the File Server Upgrade

This upgrade is for systems where GIFTS or Essential GIFTS is installed on a 
network file server that is accessible from one or more GIFTS workstations.

This upgrade includes a Server Upgrade process—which upgrades the shared 
files and GIFTS database on the server—and a Workstation Upgrade which 
upgrades the files on each GIFTS workstation. To perform this type of 
upgrade, please refer to “File Server Upgrade” on page 98.

Note: If you have a Microsoft SQL Server or Oracle server backend, please 
refer to “Upgrading GIFTS Client/Server Installations” on page 105 for 
upgrade instructions.

System Files

For a complete list of the system files installed by the GIFTS upgrade, 
consult the “GIFTS 6.6 Impact Analysis” on page 150.

How to Obtain Technical Support

If you have any difficulties during this process, please contact MicroEdge 
Technical Support in one of the following ways:

❖ by creating a New Case on PowerME. Go to 
http://www.microedge.com and log in to the PowerME support website.

❖ by email at helpdesk@microedge.com

❖ by phone at (877) 704-3343
Before You Begin 91

http://www.microedge.com/support


Upgrading a GIFTS Standalone Workstation or File Server6

❖ by fax at (212) 757-1784
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Standalone Upgrade

This type of upgrade is for clients who have purchased a single-user version 
of GIFTS or Essential GIFTS and who have installed the entire GIFTS 
system on the hard drive of a single workstation.

Step 1: Upgrading Your GIFTS Configuration File

If you received a new Configuration File from MicroEdge with your 
upgrade, perform the following procedure to update your configuration. If 
you do not update your configuration file, any new features that you 
purchased—such as MyGIFTS—will not be enabled.

Note: Only clients who purchase additional modules receive a Configuration 
File with their upgrade package; most clients do not receive a new Configuration 
File. If you did not receive a Configuration File, please skip to “Step 2: 
Upgrading Program Files”.

To update your GIFTS configuration file:

1 Copy the gifts.cfg file to the \GIFTS directory on your workstation. A 
message warns that you are overwriting an existing file. Click Yes to 
continue.

2 In the \GIFTS directory, right-click on the gifts.cfg file and select Properties.

3 On the General tab of the properties window, clear the check box for the 
Read-only option. (If the Read-only option is already off, you do not need 
to make any changes.)

4 Click OK to save the gifts.cfg properties.
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Step 2: Upgrading Program Files

Before You Begin: To avoid software conflicts, please close all other applications 
on the workstation before proceeding.

To upgrade your standalone GIFTS workstation:

1 Refer to the Upgrade email sent to you by MicroEdge and follow the 
instructions for downloading the Upgrade Installation Files. 

Note: Save the downloaded file(s) to a location on your workstation or 
server that will be easy to find. 

2 Once the download is complete, extract all files from the zip file(s).

3 Navigate to the Master/Install folder for GIFTS and double-click the 
Setup.exe file. Click Run at the Security Warning prompt.

4 At the MicroEdge GIFTS Installation Wizard window, click Next. The 
Select Setup Type window opens.

Note: Throughout the upgrade, you can click Next to continue, Back to 
return to the previous screen, or Cancel to cancel the installation.

5 Select the “Local Installation (single user)” option and click Next. The 
Select Program Folder window opens.

6 In the Select Program Folder window, choose where you want the GIFTS 
program icons to be displayed in the Windows Start menu, and click Next. 
The Start Copying Files window opens.

7 Read the summary provided of the upgrade options you chose. The 
Current Settings field should indicate that a “Local GIFTS Installation” is 
to take place in the folder you specified; the following line should note 
that this is an “Upgrade of an existing installation.”

If the options are correct, click Next to begin the upgrade.
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8 If your computer is not running a compatible version of the Microsoft Data 
Access Components (MDAC) software needed to run GIFTS, you are 
prompted to install it. Click OK and follow the on-screen instructions to 
complete the MDAC installation.

Note: After the MDAC installation, a message may inform you that your 
computer must be restarted to continue. Agree to the restart. After the 
computer has restarted, the setup program continues at step 9.

9 When the upgrade is complete, the Setup Complete window opens. In 
this window you are given the option to upgrade your GIFTS database.

Important: If the Setup Complete window with the message prompting you 
to perform the database upgrade does not appear, go to “Step 3: Manually 
Upgrading the Database” on page 96 and run the database upgrade 
manually.

If you want to run the database upgrade now, select the Run GIFTS 6.6 
Database Upgrade check box and click Finish. 

Tip: The database upgrade can take a significant amount of time to 
complete depending on the current size of your database.
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Important: The database upgrade makes irreversible changes to your 
database. Before proceeding, make sure that you have a current backup 
of your database.

❖ If you have not backed up your current database, or want to perform 
the database upgrade later for any reason, clear the check box and 
click Finish. Use instructions found in “Step 3: Manually Upgrading 
the Database” on page 96 to run the upgrade yourself after backing 
up the database.

(If the message prompting you to perform the database upgrade does not 
appear, go to “Step 3: Manually Upgrading the Database” on page 96 and 
run the database upgrade manually.)

Congratulations! If you have performed the database upgrade, your upgrade 
is complete, and you may resume your use of GIFTS.

Step 3: Manually Upgrading the Database

Note: Upgrading the database can take a significant amount of time to 
complete. Please take this into consideration when scheduling your upgrade.

Follow the instructions below only if you did not upgrade the database at the 
end of the process described in “Step 2: Upgrading Program Files” on 
page 94.

!
Caution: The database upgrade makes irreversible changes to your GIFTS 
database. Before proceeding, make sure that you have a current backup of 
your database.

To upgrade your GIFTS database for use with version 6.6:

1 From the Windows Start menu, select Run.

2 Browse to locate the GIFTS Master/Install folder and double-click on the 
Setup.exe file. This will essentially run through the GIFTS install again.
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3 When you reach the Setup Complete window, make sure the Run GIFTS 

6.6 Database Upgrade check box is selected and and click Finish to run 
the upgrade.

4 A process log indicates the progress of the upgrade, and a message 
indicates when the upgrade has successfully completed. Click OK to 
continue.

If you receive a message that the upgrade did not complete successfully, 
click Print or Save As to keep the log and fax it to MicroEdge Technical 
Support at (212) 757-1784 or email it to helpdesk@microedge.com.

Congratulations! Your GIFTS or Essential GIFTS upgrade is complete, and 
you may resume your use of GIFTS.
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File Server Upgrade

This type of upgrade is for GIFTS or Essential GIFTS systems installed on a 
network file server and one or more GIFTS workstations.

In a network environment, the database, program files, and report and 
correspondence templates that reside on your file server must be upgraded 
first. This part of the upgrade is the Server Upgrade, and it is run only once. 
The server upgrade can be run from any GIFTS workstation using the 
MicroEdge GIFTS Upgrade Installation Files. 

The Server Upgrade includes the following steps:

❖ “Step 1: Updating Your GIFTS Configuration File” on page 98

❖ “Step 2: Upgrading the GIFTS File Server” on page 99

❖ “Step 3: Manually Upgrading the GIFTS Database” on page 101

❖ “Step 4: Upgrading Other GIFTS Workstations” on page 102

Workstation upgrades are not performed using the MicroEdge GIFTS CD; 
the workstation setup program is placed on the file server during the server 
upgrade, and should be used for all workstation upgrades.

Step 1: Updating Your GIFTS Configuration File

If you received a new Configuration file from MicroEdge with your 
upgrade, perform the following procedure to update your configuration. If 
you do not update your configuration file, any new features that you 
purchased—such as MyGIFTS—will not be enabled.

Note: Only clients who purchase additional modules receive a Configuration 
file with their upgrade package; most clients do not receive a new Configuration 
file. If you did not receive a Configuration file, please skip to “Step 2: 
Upgrading the GIFTS File Server”.

To update your GIFTS configuration file:

1 Copy the gifts.cfg file to the \GIFTS directory on your GIFTS file server. A 
message warns that you are overwriting an existing file. Click Yes to 
continue.
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2 In the \GIFTS directory, right-click on the gifts.cfg file and select Properties.

3 On the General tab of the properties window, clear the check box for the 
Read-only option. (If the Read-only option is already off, you do not need 
to make any changes.)

4 Click OK to save the gifts.cfg properties.

Step 2: Upgrading the GIFTS File Server

This process will upgrade your GIFTS file server and the workstation from 
which you run the upgrade process. The upgrade process also gives you the 
option to run the GIFTS database upgrade.

Important: This process must be performed from a workstation already 
configured to run GIFTS. Please be sure that the workstation has at least 
25MB of available disk space for temporary files. The upgrade may not 
complete successfully if the workstation does not have sufficient disk space.

To upgrade your GIFTS file server and the current workstation:

1 Refer to the Upgrade email sent to you by MicroEdge and follow the 
instructions for downloading the Upgrade Installation Files. 

Note: Save the downloaded file(s) to a location on your workstation or 
server that will be easy to find. 

2 Once the download is complete, extract all files from the zip file(s).

3 Navigate to the Master/Install folder for GIFTS and double-click the 
Setup.exe file. Click Run at the Security Warning prompt.

4 At the MicroEdge GIFTS Installation Wizard window, click Next. The 
Select Setup Type window opens.

Note: Throughout the upgrade, you can click Next to continue, Back to 
return to the previous screen, or Cancel to cancel the installation.

5 Select the “Network Installation” option and click Next. The Select 
Program Folder window opens.
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6 In the Select Program Folder window, choose where you want the GIFTS 

program icons to be displayed in the Windows Start menu, and click Next. 
The Start Copying Files window opens.

7 Read the summary provided of the installation options you chose. The 
Current Settings field should indicate that a “GIFTS Server Installation” 
is to take place in the folder you specified; the following line should note 
that this is an “Upgrade to an existing installation.”

If the options are correct, click Next to begin the upgrade.

8 If your GIFTS workstation is not running a compatible version of the 
Microsoft Data Access Components (MDAC) software needed to run 
GIFTS, you are prompted to install it. Click OK and follow the on-screen 
instructions to complete the MDAC installation.

Note: After the MDAC installation, a message may inform you that your 
computer must be restarted to continue. Agree to the restart. After the 
computer has restarted, the setup program continues at step 9.

9 When the upgrade is complete, a message opens, indicating that you must 
run the GIFTS 6.6 Database Upgrade before you can use GIFTS.

Important: If the Setup Complete window with the message prompting you 
to perform the database upgrade does not appear, go to “Step 3: Manually 
Upgrading the GIFTS Database” on page 101 and run the database 
upgrade manually.

The database upgrade makes irreversible changes to your database. Before 
proceeding, make sure that you have a current backup of your database.

❖ If you have not backed up your current database, clear the check box 
and click Finish. Use instructions found in “Step 3: Manually 
Upgrading the GIFTS Database” on page 101 to run the upgrade 
yourself after backing up the database.

❖ If you want to run the database upgrade now, select the “Run GIFTS 
6.6 Database Upgrade” check box and click Finish to run the 
upgrade. 

Note: Note that the database upgrade can take a significant amount of time 
to complete.
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Once the database upgrade is complete, you can proceed to “Step 4: 
Upgrading Other GIFTS Workstations” on page 102.

Step 3: Manually Upgrading the GIFTS Database

Important: This upgrade needs to be run only once: If you chose to upgrade 
your database at the end of the preceding step, you may skip this section and 
proceed to “Step 4: Upgrading Other GIFTS Workstations” on page 102.

This step updates the structure of your GIFTS database and performs data 
updates to make your database compatible with GIFTS 6.6. Users will not be 
able to log in to GIFTS 6.6 until the database is upgraded.

Note: Upgrading the database can take a significant amount of time to 
complete. Please take this into consideration when scheduling your database 
upgrade.

This process must be run on a workstation already configured for GIFTS 
6.6. Either run it from the same workstation you used for “Step 2: 
Upgrading the GIFTS File Server”, or upgrade a workstation according to 
the instructions in “Step 4: Upgrading Other GIFTS Workstations” on 
page 102, then use it to run the database upgrade following the directions in 
this section.

!
Caution: The database upgrade makes irreversible changes to your database. 
Before proceeding, make sure that you have a current backup of your 
database.

1 At the workstation you just upgraded in Step 3, open the Windows Start 
menu and select Run.

2 Browse to locate the GIFTS Master/Install folder and double-click on the 
Setup.exe file. This will essentially run through the GIFTS install again.

3 When you reach the Setup Complete window, make sure the Run GIFTS 
6.6 Database Upgrade check box is selected and and click Finish to run 
the upgrade.A process log indicates the progress of the upgrade, and a 
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message indicates when the upgrade has successfully completed. Click OK 
to continue.

If you receive a message that the upgrade did not complete successfully, 
click Print or Save As to keep the log and fax it to MicroEdge Technical 
Support at (212) 757-1784 or email it to helpdesk@microedge.com.

Step 4: Upgrading Other GIFTS Workstations

The next step is to perform the Workstation Upgrade on your remaining 
GIFTS workstations. This process updates the workstation files needed to 
run GIFTS.

The GIFTS Workstation Upgrade must be run on every workstation that has 
access to GIFTS—except the GIFTS workstation used for “Step 2: 
Upgrading the GIFTS File Server” on page 99. That workstation was 
upgraded during the file server upgrade process.

Important: The workstation upgrade must be run from a network copy of the 
Setup program.

To upgrade a workstation:

1 Run the Setup.exe file located within the GIFTS\Setup directory on your 
file server.

Example: If you designated P:\GIFTS as your GIFTS directory, the Setup.exe 
file is located at P:\GIFTS\Setup\Setup.exe.

The GIFTS Welcome screen is displayed.

2 Click Next. The Select Program Folder window opens.

3 In the Select Program Folder window, choose where you want the GIFTS 
program icons to be displayed in the Windows Start menu, and click Next. 
The Start Copying Files window opens.

4 Read the summary provided of the installation options you chose. The 
Current Settings field should indicate that a “GIFTS Workstation 
Installation” is to take place in the folder you specified; the following line 
should note that this is an “Upgrade to an existing installation.”

If the options are correct, click Next. The upgrade begins.
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5 If the workstation is not running a compatible version of the Microsoft 

Data Access Components (MDAC) software needed to run GIFTS, you 
are prompted to install it. Click OK and follow the on-screen instructions 
to complete the MDAC installation.

Note: After the MDAC installation, a message may inform you that your 
computer must be restarted to continue. Agree to the restart. After the 
computer has restarted, the setup program continues at step 6.

6 When the upgrade is complete, you are notified. Click Finish.

Congratulations! After performing upgrades to all GIFTS workstations, 
your GIFTS or Essential GIFTS upgrade is complete. You may resume your 
use of GIFTS.

Important: If you have MyGIFTS or ReviewerCONNECT, you now need to 
upgrade GIFTS Connections. Please refer to the GIFTS Connections: 
MyGIFTS and ReviewerCONNECT Installation and Technical Reference Guide for 
more information.
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Before You Begin

This process upgrades your GIFTS 6.4 or 6.5 system to GIFTS 6.6. To 
determine which version of GIFTS you have, choose Help > About from the 
menu of any GIFTS module.

!
Caution: If you have a version of GIFTS earlier than GIFTS 6.4, please contact 
MicroEdge Technical Support. If you attempt to upgrade an earlier GIFTS 
system, your database upgrade will fail and you will have to restore your 
backup of the GIFTS system.

The following important points should be addressed before you upgrade 
GIFTS:

❖ Your program, database, reports, and template files are altered by this 
process. Before proceeding, make a complete backup of your GIFTS 
database—as well as the GIFTS directory on your file server.

❖ All users must be logged out of GIFTS for the duration of the upgrade.

❖ Upgrading GIFTS can take a significant amount of time. If you use 
MyGIFTS or ReviewerCONNECT, you will have to upgrade to GIFTS 
Connections at the conclusion of the GIFTS upgrade. Please review the 
GIFTS Connections: MyGIFTS and ReviewerCONNECT Installation and 
Technical Reference Guide and consider your upgrade of GCS when you 
make plans for the time and resources needed to complete your upgrade.

❖ If you are using any virus-protection software, please disable it before you 
upgrade GIFTS. Virus-protection programs may cause errors during the 
upgrade process.

❖ If Crystal Reports is installed on your system, be sure to read 
“Compatibility with Crystal Reports” on page 164.

The points above are vital to ensuring that your upgrade is successful. Please 
make sure that each issue has been thoroughly addressed before continuing.
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System Files

For a complete list of the system files installed by the GIFTS setup process, 
consult the “Installation Impact Analysis” on page 149.

How to Obtain Technical Support

If you have any difficulties during this process, please contact MicroEdge 
Technical Support in one of the following ways:

❖ by creating a New Case on PowerME. Go to 
http://www.microedge.com and log in to the PowerME support website.

❖ by email at helpdesk@microedge.com

❖ by phone at (877) 704-3343

❖ by fax at (212) 757-1784

The procedures outlined below will take you through the process of 
upgrading the GIFTS client/server edition for Microsoft SQL Server or 
Oracle server.

Overview of the Upgrade Process

The upgrade process includes four major steps:

Step 1: Important Prerequisites The preparation steps are essential for 
ensuring that the upgrade process runs properly.

Step 2: Upgrading the File Server This process upgrades shared files on the 
network server, including the program and report files, and is run only once. 
The server upgrade must run from a GIFTS workstation.

Step 3: Upgrading the GIFTS Database This process upgrades the structure 
of the database on the database server, including the addition of new fields 
required by GIFTS 6.6. This part of the upgrade is run only once.

Step 4: Upgrading Your GIFTS Workstations This process upgrades your 
remaining workstations. This part of the upgrade must be run on every 
workstation that has access to GIFTS.
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To complete the upgrade, you must complete these steps in the order in 
which they are presented. 

Note: Clients with MyGIFTS or ReviewerCONNECT should upgrade GIFTS 
Connections after completing the GIFTS upgrade process. Please refer to the 
GIFTS Connections: MyGIFTS and ReviewerCONNECT Installation and Technical 
Reference Guide for more information.
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Step 1: Important Prerequisites

Before beginning the upgrade, make sure your network environment and 
GIFTS configuration are ready.

Preparing Your Environment

Upgrading to GIFTS 6.6 alters your program, database, reports, and 
template files. The following important points should be addressed before 
you perform the upgrade:

❖ Make a complete backup of your current GIFTS directory and the GIFTS 
database on your Microsoft SQL or Oracle server.

❖ Microsoft SQL Server users should run the DBCC CHECKDB function 
(database consistency check) to locate and correct errors in the logical or 
physical consistency of the GIFTS database. For more information about 
this process, please consult your SQL Server documentation.

❖ Ensure that your database server is compatible with GIFTS 6.6. For a list 
of compatible server versions, please refer to the GIFTS 6.6 and GCS 3.6 
Compatibility Fact Sheet available in the PowerME portal.

❖ GIFTS connects to the database server using ODBC drivers, which are 
installed during the upgrade process. Please refer to the GIFTS 6.6 and 
GCS 3.6 Compatibility Fact Sheet available in the PowerME portal for a 
list of certified drivers.

To check the version of the ODBC driver installed on a workstation, you 
can use the “Data Sources (ODBC)” Control Panel.

❖ If you are using any virus-protection software, please make sure that it is 
disabled before you run the upgrade. An active virus-protection program 
may cause errors during the upgrade process.

❖ If you use or intend to use Crystal Reports, make sure to read 
“Compatibility with Crystal Reports” on page 164.

❖ GIFTS 6.6 requires a comparable amount of hard disk space to previous 
versions of GIFTS. Please refer to “GIFTS Storage Requirements” on 
page 7 for more information.
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Important: The above points are vital to ensuring that your upgrade is 
successful. Please make sure that each issue has been thoroughly addressed 
before you continue.

Updating Your GIFTS Configuration File

If you received a new Configuration file from MicroEdge with your upgrade 
download, perform the following procedure to update your configuration. If 
you do not update your configuration file, any new features that you 
purchased—such as MyGIFTS—will not be enabled.

Note: Only clients who purchase additional modules receive a Configuration 
file with their upgrade package; most clients do not receive a new Configuration 
file. If you did not receive a Configuration File, please proceed to “Step 2: 
Upgrading the File Server” on page 111.

To update your GIFTS configuration file:

1 Copy the gifts.cfg file to the \GIFTS directory on your GIFTS file server. A 
message warns that you are overwriting an existing file. Click Yes to 
continue.

2 In the \GIFTS directory, right-click on the gifts.cfg file and select Properties.

3 On the General tab of the properties window, clear the check box for the 
Read-only option. (If the Read-only option is already off, you do not need 
to make any changes.)

4 Click OK to save the gifts.cfg properties.
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Step 2: Upgrading the File Server

You can run the file server upgrade process from any GIFTS workstation. 
The setup process uses the information contained in the workstation’s 
gifts.ini file to determine the location of your current GIFTS system, and 
upgrades it accordingly.

Please note that the workstation from which you run the file server upgrade 
is also upgraded to a GIFTS 6.6 workstation during this process.

Before You Begin: Please be sure that the workstation from which you are 
running the server upgrade has at least 25MB of available disk space for 
temporary files. The server upgrade may not complete successfully if the 
workstation does not have sufficient disk space.

To upgrade your GIFTS file server and the current workstation:

1 Refer to the Upgrade email sent to you by MicroEdge and follow the 
instructions for downloading the Upgrade Installation Files. 

Note: Save the downloaded file(s) to a location on your workstation or 
server that will be easy to find. 

2 Once the download is complete, extract all files from the zip file(s).

3 Navigate to the Master/Install folder for GIFTS and double-click the 
Setup.exe file. Click Run at the Security Warning prompt.

4 At the MicroEdge GIFTS Installation Wizard window, click Next. The 
Select Setup Type window opens.

Note: Throughout the upgrade, you can click Next to continue, Back to 
return to the previous screen, or Cancel to cancel the installation.

5 Select the “Network Installation” option and click Next. The Select 
Program Folder window opens.

6 In the Select Program Folder window, choose where you want the GIFTS 
program icons to be displayed in the Windows Start menu, and click Next. 
The Start Copying Files window opens.
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7 Read the summary provided of the installation options you chose. The 

Current Settings field should indicate that a “GIFTS Server Installation” 
is to take place in the folder you specified; the following line should note 
that this is an “Upgrade to an existing installation.”

If the options are correct, click Next. The upgrade begins.

8 If your file server is not running a compatible version of the Microsoft Data 
Access Components (MDAC) software needed to run GIFTS, you are 
prompted to install it. Click OK and follow the on-screen instructions to 
complete the MDAC installation.

Note: After the MDAC installation, a message may inform you that your 
computer must be restarted to continue. Agree to the restart. After the 
computer has restarted, the setup program continues at step 9.

9 When the upgrade is complete, the Setup Complete window opens. In 
this window you are given the option to upgrade your GIFTS database.

Important: If the Setup Complete window with the message prompting you 
to perform the database upgrade does not appear, go to “Step 3: 
Upgrading the GIFTS Database” on page 113 and run the database 
upgrade manually.

If you want to run the database upgrade now, select the Run GIFTS 6.6 
Database Upgrade check box and click Finish. 

Tip: The database upgrade can take a significant amount of time to 
complete depending on the current size of your database.

Important: The database upgrade makes irreversible changes to your 
database. Before proceeding, make sure that you have a current backup 
of your database.

❖ If you have not backed up your current database, or want to perform 
the database upgrade later for any reason, clear the check box and 
click Finish. Use instructions found in “Step 3: Upgrading the GIFTS 
Database” on page 113 to run the upgrade yourself after backing up 
the database.

Once the database upgrade is complete, you can proceed to “Step 4: 
Upgrading Your GIFTS Workstations” on page 115.
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Step 3: Upgrading the GIFTS Database

Important: This upgrade needs to be run only once: If you chose to upgrade 
your database at the end of the preceding section, skip this section and go to 
“Step 4: Upgrading Your GIFTS Workstations” on page 115.

This step updates the structure of your GIFTS database and performs data 
updates to make your database compatible with GIFTS 6.6.

Note: Upgrading the database can take a significant amount of time to 
complete. Please take this into consideration when scheduling your database 
upgrade.

This process must be run on a workstation already configured for GIFTS 
6.6. Either run it from the same workstation you used for “Step 2: 
Upgrading the File Server”, or upgrade a workstation according to the 
instructions in “Step 4: Upgrading Your GIFTS Workstations” on page 115 
and use it to run the database upgrade following the directions below.

!
Caution: The database upgrade makes irreversible changes to your GIFTS 
database. Before proceeding, make sure that you have a current backup of 
your database.

To upgrade your GIFTS database:

1 At the workstation you upgraded in Step 2, open the Windows Start menu 
and select Run.

2 Browse to locate the GIFTS Master/Install folder and double-click on the 
Setup.exe file. This will essentially run through the GIFTS install again.

3 When you reach the Setup Complete window, make sure the Run GIFTS 
6.6 Database Upgrade check box is selected and and click Finish to run 
the upgrade.
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4 A process log indicates the progress of the upgrade, and a message 

indicates when the upgrade has successfully completed. Click OK to 
continue.

If you receive a message that the upgrade did not complete successfully, 
click Print or Save As to keep the log and fax it to MicroEdge Technical 
Support at (212) 757-1784 or email it to helpdesk@microedge.com.
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Step 4: Upgrading Your GIFTS Workstations

The next step is to perform the Workstation Upgrade on your remaining 
workstations. This process updates the system files the workstations need to 
run GIFTS. Clients with Oracle server may also need to update the ODBC 
data source on each workstation.

Running the Workstation Upgrades

The GIFTS Workstation Upgrade must be run on every workstation that has 
access to GIFTS except the workstation used to run the file server upgrade. 
That workstation was updated during the file server upgrade process.

Important: The workstation upgrade must be run from a network copy of the 
Setup program.

To upgrade a GIFTS workstation:

1 Run the Setup.exe file located within the GIFTS\Setup directory on your 
file server.

Example: If you designated P:\GIFTS as your GIFTS directory, the Setup.exe 
file is located at P:\GIFTS\Setup\Setup.exe.

The GIFTS Welcome screen is displayed.

2 Click Next. The Select Program Folder window opens.

3 In the Select Program Folder window, choose where you want the GIFTS 
program icons to be displayed in the Windows Start menu, and click Next. 
The Start Copying Files window opens.

4 Read the summary provided of the installation options you chose. The 
Current Settings field should indicate that a “GIFTS Workstation 
Installation” is to take place in the folder you specified; the following line 
should note that this is an “Upgrade to an existing installation.”

If the options are correct, click Next. The upgrade begins.

5 If the workstation is not running a compatible version of the Microsoft 
Data Access Components (MDAC) software needed to run GIFTS, you 
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are prompted to install it. Click OK and follow the on-screen instructions 
to complete the MDAC installation.

Note: After the MDAC installation, a message may inform you that your 
computer must be restarted to continue. Agree to the restart. After the 
computer has restarted, the setup program continues at step 6.

6 When the upgrade is complete, you are notified. Click Finish.

7 If you have an Oracle server system, please refer to the procedure in the 
following section, “Updating the Data Source on Oracle Systems”, for 
information about updating the ODBC data source on the workstation.

Repeat this procedure on each GIFTS workstation. Once you have upgrade 
all of your GIFTS workstations, your GIFTS upgrade is complete! You may 
now resume your use of GIFTS.

Important: If you have MyGIFTS or ReviewerCONNECT, you now need to 
upgrade GIFTS Connections. Please refer to the GIFTS Connections: 
MyGIFTS and ReviewerCONNECT Installation and Technical Reference Guide for 
more information.

Updating the Data Source on Oracle Systems

If you have an Oracle server system and are upgrading from GIFTS 6.4—or 
if you have an Oracle server system and did not update the ODBC data 
source on your GIFTS workstations when you upgraded—use the following 
procedure on each GIFTS workstation to update your ODBC data source.

!
Caution: If you have a version of GIFTS earlier than GIFTS 6.4, please contact 
MicroEdge Technical Support. If you attempt to upgrade an earlier GIFTS 
system, your database upgrade will fail and you will have to restore your 
backup of the GIFTS system.

This procedure updates the ODBC data source on the workstation to specify 
the certified Crystal Reports ODBC driver listed in the “Compatibility Fact 
Sheet” for GIFTS 6.6. This driver is required by the Crystal Reports viewer 
used in the GIFTS Report Library. GIFTS uses a different ODBC driver (as 
116 Step 4: Upgrading Your GIFTS Workstations



Upgrading GIFTS Client/Server Installations 7

specified in the fact sheet), but uses the information in this data source to 
locate the GIFTS database.

To update the data source for a GIFTS workstation: 

1 In the Administrative Tools folder of the Windows Control Panel, double-
click the “Data Sources (ODBC)” icon to open the ODBC Data Source 
Administrator.

2 Click the System DSN tab. The data sources for the workstation are listed.

3 Highlight the data source currently being used to connect to the GIFTS 
database (the default DSN name is GIFTS), and click Remove. The data 
source is removed.

4 On the System DSN tab, click Add. The Create New Data Source window 
is displayed.

5 From the list of ODBC Drivers, choose CR Oracle ODBC Driver 5.0 and 
click Finish. The ODBC Oracle Driver Setup window is displayed.

6 In the Data Source Name field, enter GIFTS (or the DSN that you use for 
your GIFTS database).

7 In the Server Name field, enter the name of the database server you are 
using with GIFTS.

8 Click OK and close the ODBC Administrator. You now have an ODBC 
Data Source named GIFTS.
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Before You Begin

This process upgrades your GIFTS 6.4 or 6.5 system to Version 6.6. To 
determine which version of GIFTS you have, choose Help > About from the 
menu of any GIFTS module.

!
Caution: If you have a version of GIFTS earlier than GIFTS 6.4, please contact 
MicroEdge Technical Support. If you attempt to upgrade an earlier GIFTS 
system, your database upgrade will fail and you will have to restore your 
backup of the GIFTS system.

The following important points should be addressed before you upgrade 
GIFTS:

❖ Your program, database, reports, and template files are altered by this 
process. Please make a complete backup of your current GIFTS directory 
before proceeding.

❖ All users must be logged out of GIFTS for the duration of the upgrade.

❖ If you are using any virus-protection software, please disable it before you 
upgrade GIFTS. Virus-protection programs may cause errors during the 
upgrade process.

❖ If Business Objects Crystal Reports is installed on your system, be sure to 
read “Compatibility with Crystal Reports” on page 164.

❖ Read the following sections, “Option 1: Citrix Workstation Upgrade” and 
“Options 2: Citrix Standalone Upgrade”, to determine which type of 
upgrade you need to perform. If your configuration is not included among 
these options, please contact MicroEdge Technical Support for advice.

The points above are vital to ensuring that your upgrade is successful. Please 
make sure that each issue has been thoroughly addressed before continuing. 
The options that follow describe the different types of GIFTS installations 
that can be upgraded using the procedures in this chapter.
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Option 1: Citrix Workstation Upgrade

This type of upgrade is for clients who have installed the GIFTS workstation 
software on a computer running Citrix, as described in “Option 1: Installing 
a GIFTS Workstation on Your Server” on page 82. 

In this process, you will upgrade your GIFTS system—and then upgrade the 
workstation that is running Citrix Presentation Server. To perform this type 
of upgrade, please refer to “Upgrading a GIFTS Workstation Running 
Citrix” on page 123.

Options 2: Citrix Standalone Upgrade

This upgrade is for systems where the entire GIFTS system has been 
installed on a single computer running Citrix, as described in “Option 2: 
Installing a Standalone System on Your Server” on page 86. 

In this process, you will simply upgrade the GIFTS system on that 
computer, as described in “Upgrading a Standalone System Running Citrix” 
on page 126.

Other Upgrade Options

If neither of the two preceding options applies to your GIFTS system, please 
contact MicroEdge Technical Support for advice regarding your upgrade of 
GIFTS with Citrix Presentation Server.

System Files

For a complete list of the system files installed by the GIFTS upgrade, 
consult the “Installation Impact Analysis” on page 149.

How to Obtain Technical Support

If you have any difficulties during this process, please contact MicroEdge 
Technical Support in one of the following ways:

❖ by submitting an electronic support request. Go to 
http://www.microedge.com/support and log in to the support website.
Before You Begin 121



Upgrading GIFTS with Citrix Presentation Server8

❖ by email at helpdesk@microedge.com

❖ by phone at (877) 704-3343

❖ by fax at (212) 757-1784
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Upgrading a GIFTS Workstation Running 
Citrix

This procedure describes how to upgrade the GIFTS software on a GIFTS 
workstation running Windows Terminal Services with Citrix Presentation 
Server.

Step 1: Upgrade Your GIFTS System

The first step is to upgrade all parts of your GIFTS system except the 
workstation that you use to provide access through Citrix Presentation 
Server. To upgrade GIFTS, please follow the instructions for your system 
configuration:

❖ Clients with a file server system should refer to the instructions in 
“Upgrading a GIFTS Standalone Workstation or File Server” on page 89.

❖ Clients with a Microsoft SQL Server or Oracle server environment should 
follow the instructions in“Upgrading GIFTS Client/Server Installations” 
on page 105.

Note: If you wish to upgrade a standalone GIFTS system, please refer to 
“Upgrading a Standalone System Running Citrix” on page 126.

Step 2: Disabling Remote Logons

Before upgrading GIFTS, you should disable remote logons to your Citrix 
Presentation Server. To do so, please follow the instructions in “Step 2: 
Disabling Remote Logons” on page 82. Then, proceed to the next step.

Step 3: Upgrading GIFTS on Your Citrix Server

Before You Begin: Please review the following important information regarding 
the upgrade of GIFTS with Citrix:

❖ You must launch the GIFTS Setup program from within the Add/Remove 
Programs Control Panel, as described in this procedure. If you do not run 
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GIFTS Setup from within the Control Panel, GIFTS will not run under 
Terminal Services.

❖ If you are prompted to restart the computer during the upgrade 
procedure, choose to Restart later. You must complete the entire GIFTS 
upgrade process and close the Add/Remove Programs utility before 
restarting the computer.

❖ At the conclusion of the GIFTS Setup process, you should close the Add/
Remove Programs utility before proceeding; make sure that the GIFTS 
upgrade is complete before closing the utility.

To upgrade GIFTS on your Citrix Presentation Server:

1 From the Windows Start menu of the computer running Citrix, choose 
Control Panel ➤ Add or Remove Programs.

2 In the left column, click Add New Programs. The options for adding 
programs are displayed.

3 Click the CD or Floppy button.

4 Browse to and run the Setup program located in the GIFTS directory of 
your GIFTS file server.

Example: If you designated P:\GIFTS as your GIFTS directory, the Setup.exe 
file is located at P:\GIFTS\Setup\Setup.exe.

The GIFTS Setup process begins.

5 You may now upgrade GIFTS, as described in the section that applies to 
your configuration of GIFTS:

Important Reminder: You must run the GIFTS Setup program from within the 
Add/Remove Programs Control Panel.

❖ File server installations – please refer to “Step 4: Upgrading Other 
GIFTS Workstations” on page 102. 

❖ SQL Server and Oracle installations – please refer to “Step 4: 
Upgrading Your GIFTS Workstations” on page 115.

When you have finished upgrading the GIFTS workstation software, you 
may proceed to the next step.
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Step 4: Copying the GIFTS Help Files

To make the GIFTS online help available to each user, this procedure 
describes how make the GIFTS help files available to users who access 
GIFTS through Citrix Presentation Server:

1 Using Windows Explorer, open the WINDOWS or WINNT folder of your 
Windows Terminal Server. For example:

M:\WINDOWS

2 Copy the following GIFTS help files:

3 Paste the GIFTS help files to the virtual WINDOWS or WINNT directory 
of each user who uses GIFTS through Citrix. The locations of these virtual 
directories follow this pattern:

M:\Documents and Settings\[User Name]\WINDOWS

(where [User Name] is the network name or login ID for each user)

The GIFTS help files are now available to your users. Please continue to the 
next step to complete your upgrade.

Step 5: Completing Your Upgrade

To complete your upgrade, just re-enable logons to your server. Your 
upgrade of GIFTS with Citrix is complete! 

empadmin.chm gfwbudget.chm

empgifts.chm gfwgam.chm

gfw60.chm gifts.chm

gfwadmin.chm mesupp.chm

gfwap.chm ChartFX_98_GUI.hlp
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Upgrading a Standalone System Running 
Citrix

This procedure describes how to upgrade a standalone GIFTS system on a 
computer running Citrix Presentation Server. Using this procedure, all 
components of GIFTS will be upgraded—including the GIFTS database. 
This option does not apply to client/server systems.

Step 1: Disabling Remote Logons

Before upgrading GIFTS, you should disable remote logons to your Citrix 
Presentation Server. To do so, please follow the instructions in “Step 2: 
Disabling Remote Logons” on page 82. Then, proceed to the next step.

Step 2: Update Your GIFTS Configuration File

If you received a new Configuration file from MicroEdge with your 
upgrade, perform the following procedure to update your configuration. If 
you do not update your configuration file, any new features that you 
purchased—such as MyGIFTS—will not be enabled.

Note: Only clients who purchase additional modules receive a Configuration 
tFile with their upgrade package; most clients do not receive a new Configuration 
File. If you did not receive a Configuration file, please skip to “Step 3: 
Upgrading GIFTS”.

To update your GIFTS configuration file:

1 Copy the gifts.cfg file from your Configuration File to the \GIFTS directory 
on your server. A message warns that you are overwriting an existing file. 
Click Yes to continue.

2 In the \GIFTS directory, right-click on the gifts.cfg file and select Properties.

3 On the General tab of the properties window, clear the check box for the 
Read-only option. (If the Read-only option is already off, you do not need 
to make any changes.)

4 Click OK to save the gifts.cfg properties.
126 Upgrading a Standalone System Running Citrix



Upgrading GIFTS with Citrix Presentation Server8

Step 3: Upgrading GIFTS

Before You Begin: Please review the following important information regarding 
the upgrade of GIFTS with Citrix:

❖ You must launch the GIFTS Setup program from within the Add/Remove 
Programs Control Panel, as described in this procedure. If you do not run 
GIFTS Setup from within the Control Panel, GIFTS will not run under 
Terminal Services.

❖ If you are prompted to restart the computer during the upgrade 
procedure, choose to restart later. You must complete the entire GIFTS 
upgrade process and close the Add/Remove Programs utility before 
restarting the computer.

❖ At the conclusion of the GIFTS Setup process, you should close the Add/
Remove Programs utility before proceeding; make sure that the GIFTS 
upgrade is complete before closing the utility.

To upgrade a standalone GIFTS system on your Terminal Server:

1 From the Windows Start menu, choose Control Panel ➤ Add or Remove 
Programs.

2 In the left column, click Add New Programs. The options for adding 
programs are displayed.

3 Click the CD or Floppy button.

4 Browse to the location of the GIFTS Upgrade files and run the Setup file.

5 Click Next. The GIFTS Setup process begins.

Important Reminder: You must run the GIFTS Setup program from within the 
Add/Remove Programs Control Panel.

6 You may now continue with your GIFTS upgrade. To do so, please follow 
the steps in “Step 2: Upgrading Program Files” on page 94.

7 If you did not elect to upgrade your database during the previous step, 
please follow the instructions in “Step 3: Manually Upgrading the 
Database” on page 96 to do so.
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When you have finished upgrading GIFTS, you may proceed to the next 
step.

Step 4: Copying the GIFTS Help Files

To make the GIFTS online help available to each user, this procedure 
describes how make the GIFTS help files available to users who access 
GIFTS through Citrix Presentation Server:

1 Using Windows Explorer, open the WINDOWS or WINNT folder of your 
Windows Terminal Server. For example:

M:\WINDOWS

2 Copy the following files:

3 Copy the GIFTS help files to the virtual WINDOWS or WINNT directory 
of each user who uses GIFTS through Citrix. The locations of these virtual 
directories follow this pattern:

M:\Documents and Settings\[User Name]\WINDOWS

(where [User Name] is the network name or login ID for each user)

The GIFTS help files are now available to your users. Please continue to the 
next step to complete your upgrade.

Step 5: Completing Your Upgrade

To complete your upgrade, just re-enable logons to your Presentation 
Server. Your upgrade of GIFTS with Citrix is complete!

empadmin.chm gfwbudget.chm

empgifts.chm gfwgam.chm

gfw60.chm gifts.chm

gfwadmin.chm mesupp.chm

gfwap.chm ChartFX_98_GUI.hlp
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9 Maintenance,
Security, and Data

Integrity
This chapter describes the diagnostic and maintenance utilities 
provided for GIFTS, and the GIFTS security features. It also describes 
the products used to develop the GIFTS software.

In This Chapter
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Maintaining Your Database..................................................132

Budget Diagnostics Utility....................................................134
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GIFTS Diagnostics Utility 

The GIFTS Diagnostics utility is designed to assist MicroEdge’s Technical 
Support staff in identifying and resolving problems in your GIFTS 
installation. By using these diagnostic tools, you can provide most of the 
information Technical Support needs to assist you, without the need to 
involve additional technical staff or consultants. 

The utility includes the following features:

❖ System Information: indicates the type of database used by your 
installation of GIFTS, and provides a summary of system information like 
memory, available resources, and the current Windows Regional Settings.

❖ GIFTS Information: a summary of all of the GIFTS-related files, used to 
identify problematic versions or duplicate files. This can be used to list the 
system files installed with GIFTS, or to find specific files.

❖ List System Files: displays the contents of files that store system 
information, including the AUTOEXEC.BAT, CONFIG.SYS, gifts.ini, and 
GIFTS.SYS files.

❖ Database Test: used to verify that the workstation’s connection to the 
database is valid.

❖ Budget Verifier: used to verify data used by the optional Budget Module.

❖ Template Creation Test and Merge Letter Test: used to test the ability 
of GIFTS to created merged correspondence with Microsoft Word.

❖ IGAM Application Retrieval Test: used to verify that the optional 
Internet Grant Application Module can connect to the IGAM server and 
retrieve online applications.

To access this utility:

1 Log in to any GIFTS application.

2 From the Main menu, select Help ➤ About GIFTS.

3 Click the System Info button.
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Isolating System File Conflicts

You can use Microsoft’s MSINFO utility to isolate the system files (such as 
DLLs and OCX files) that are running when errors occur. It also facilitates 
troubleshooting by identifying the different sets of files that are installed and 
running on workstations that either do, or do not, have problems.
Isolating System File Conflicts 131



Maintenance, Security, and Data Integrity9

Maintaining Your Database

The following sections describe the utilities and procedures available for 
maintaining your GIFTS database. Note that some responsibilities for 
maintaining your database depend on whether your system uses a Microsoft 
Access database or a client/server (Microsoft SQL Server or Oracle server) 
database.

File Server Database Maintenance

MicroEdge provides a Database Maintenance Tool for the maintenance and 
correction of the Microsoft Access database used by Essential GIFTS, 
standalone installations of GIFTS, and the file server version of GIFTS.

!
Caution: The MicroEdge Database Maintenance Tool should be used only 
under the direction of MicroEdge Technical Support personnel.

This tool includes the following functions:

❖ Repair/Compact: used to repair a corrupted database, and rearranges and 
minimizes the information to reduce fragmentation. The database may 
become corrupted if GIFTS quits unexpectedly (for example, if there is a 
power outage or a hardware malfunction). Most often, GIFTS detects and 
reports database corruption problems. However, MicroEdge Technical 
Support may recommend that you run this option to eliminate corruption 
as a cause for certain unexplained errors.

❖ Copy into New Database Container: MicroEdge Technical Support may 
recommend this option if you find the need to repair the database at 
frequent intervals and there is no apparent cause for corruption.

❖ Zip Database: compresses your GIFTS database in a Zip format that you 
can then provide to MicroEdge Technical Support for research purposes.

GIFTS users can use a task scheduler to regularly compact and repair their 
database.
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Client/Server Database Maintenance

Users of all client/server systems (Microsoft SQL Server and Oracle) are 
responsible for regular maintenance and performance tuning of the GIFTS 
grants database. MicroEdge recommends the use of the latest versions of 
manufacturer-provided utility programs for this purpose. 

This routine database maintenance should be performed by a trained 
Database Administrator (DBA) in accordance with the client/server 
database manufacturer’s recommendations.

Important: Please make sure that your DBA is trained as a Microsoft SQL 
Server or Oracle Server Administrator, and is familiar with all aspects of 
setting up and administering the SQL Server or Oracle server environment. 
MicroEdge Technical Support personnel cannot provide advice or assistance 
related to the setup of your SQL Server or Oracle server software and/or 
hardware.

Recalculating Summary Data

GIFTS maintains summary data—such as the balance of a grant or the total 
number of payments for a grant—to maximize the speed of queries and 
reports. Occasionally, as users work in GIFTS, this data is not properly 
synchronized. This can happen for a variety of reasons, including network 
communication errors and hardware problems.

If you suspect that the calculations of summary data and totals in GIFTS are 
not synchronized, MicroEdge Technical Support may recommend that you 
use the Recalculate Utility to synchronize your data.

Consolidating Duplicate Records

Data entry errors can result in there being duplicate Organization or 
Contact records in your database. Using the GIFTS Administrator Module, 
you can identify duplicate records and consolidate the links to the Requests 
and Contacts associated with the duplicates into one record. Please refer to 
the GIFTS Administrator’s Guide for more information.
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Budget Diagnostics Utility

The Budget Module Diagnostics Utility helps MicroEdge Technical Support 
locate any problems you may encounter with data for the optional Budget 
Module. 
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Security and Data Integrity

This section discusses the security and integrity of your data in the GIFTS 
environment. GIFTS Connections administrators face additional data 
security considerations, especially if they have MyGIFTS and/or 
ReviewerCONNECT users accessing GIFTS data over the Internet. For 
information about GIFTS Connections data security considerations, please 
refer to the GIFTS Connections: MyGIFTS and ReviewerCONNECT Installation 
and Technical Reference Guide.

Security Levels

GIFTS has advanced security features that allow multi-level program access 
based on the rights assigned to an individual or a specified group of users. 
This security is established and maintained by the GIFTS Administrator.

Password Security

GIFTS provides for the creation and maintenance of unique User IDs and 
passwords. GIFTS also supports Windows NT integrated security, which 
permits grantmakers who use Windows servers to skip the GIFTS login 
process: each user’s Windows login ID is automatically read and used by 
GIFTS. Similar login integration is provided for Microsoft SQL Server and 
Oracle databases. For more information, please refer to the GIFTS 
Administrator’s Guide.

Rollback Recovery

GIFTS offers the highest level of reliability and data-integrity possible in 
both its file server and client/server configurations by utilizing engine-level 
“transaction commit and rollback” technology. This means that if your 
computer is halted in the middle of a GIFTS fund transfer between two 
budget categories, there is no data corruption since GIFTS only commits the 
changes once the entire transaction is completed successfully.
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Audit Trail

GIFTS maintains a log of the last date of user input for all database records, 
as well as a detailed record of all critical system transactions by user, date, 
and time.

File Server Access Rights

GIFTS requires that all users have full access rights to the network directory 
and subdirectories where GIFTS is installed.

Client/Server Access Security

GIFTS provides its own internal login security, and does not handle security 
for Microsoft SQL Server and/or Oracle server. While both SQL and Oracle 
have complex security features, GIFTS does not interact with them. The 
GIFTS login used for SQL or Oracle must be the “owner” of the database or 
tables, and therefore has all of the permissions of an “owner.”

Database Backup and Recovery

It is the client’s responsibility to conduct nightly verified backups of all 
system data, to rotate media appropriately, and to replace tapes on the 
schedule that is recommended by the manufacturer. We also recommend 
that this essential data be stored both on and off site in secure fireproof and 
waterproof media safes. 

For detailed information about backing up your GIFTS system, please 
search for “backups” in the MicroEdge Solutions Knowledgebase.
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System Architecture

GIFTS has been designed following the principles specified in the Microsoft 
Windows Interface Application Design Guide and the Microsoft Windows Software 
Development Kit.

GIFTS 6.6 uses a Microsoft Access database for the standalone and file server 
editions. This database is stored in a standard .MDB file that can be read 
using the Microsoft Access application.

!
Caution: Never open the production copy of your database with Microsoft 
Access. If an experienced Access user wants to run queries or use other 
Access functions to analyze your data, create a copy of your database for 
these purposes. As described in the Client Resource Guide, MicroEdge will not 
support your GIFTS software if data is entered or modified through any 
means except the application software provided by MicroEdge.

For the client/server editions, the database is either a Microsoft SQL Server 
or Oracle server database that adheres to industry standards and an open 
architecture. All GIFTS databases are compatible with the version or 
versions of Business Objects Crystal Reports listed in the GIFTS 
Compatibility Fact Sheet on the GIFTS PowerME website (The Professional 
edition of Crystal Reports is required for client/server systems.)

Note that all editions of GIFTS provide the same user interface and 
functionality regardless of the database used. GIFTS makes extensive use of 
OLE and DDE links to launch compatible word processing and spreadsheet 
applications. It also adheres to the MAPI, VIM, and SMTP/POP standards 
for its links to compatible email packages. For a complete list of compatible 
applications, please refer to the latest version of the GIFTS Compatibility 
Fact sheet on the GIFTS PowerME website.
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10 Expanding
Your GIFTS System

This chapter describes how you can expand the functionality of 
GIFTS with optional modules, customizations, trade-ups, migration, 
or by linking GIFTS to an external system.

In This Chapter
Optional Modules and Components ....................................140

GIFTS Connections..............................................................143

System Trade-up and Migration...........................................144

Links to External Systems ....................................................146



Expanding Your GIFTS System10

Optional Modules and Components

The following optional modules and add-ons can be used with any GIFTS 
installation.

Internet Grant Application Manager

The Internet Grant Application Manager (IGAM) enables GIFTS to receive 
grant applications and requirements through the Internet. Incoming 
applications are stored separately from the main GIFTS database, and 
applications can be rejected or transferred to GIFTS for further review. After 
retrieval, requirements directly update GIFTS records. IGAM also includes a 
Forms Manager and Internet Hosting Service that you can use to create, 
post, and manage application and requirement forms.

GIFTS Plus Pack .NET Extension

The GIFTS Plus Pack .NET Extension is the foundation of the GIFTS Plus 
Pack add-on utilities, which extend the capabilities of GIFTS features like 
batch processing, charting, and requirement scheduling.

Employee GIFTS

Employee GIFTS can be used to administer matching gifts and volunteer 
gifts programs:

❖ Matching GIFTS streamlines the management and administration of 
corporate matching gifts programs. You can reduce the amount of time 
you spend entering match requests, checking eligibility, and making 
payments.

❖ Volunteer GIFTS streamlines the management and administration of gifts 
given for your employees’ volunteer projects.

Information about your gifts, payments, and employee donors is integrated 
into the main GIFTS system and becomes part of your overall grants-
tracking data.
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Check Writer

You can use the GIFTS Check Writer to print checks directly from GIFTS. 
The Check Writer prints GIFTS data—such as the grantee Organization 
Name, Project Title, and Payment Amount—on your checks and maintains 
a detailed check register for each bank account from which you draw funds.

Accounts Payable Links

You can use A/P links to generate export files that contain your payment 
data. These files can be imported into your accounting software, which is 
used to generate invoices and checks. After your checks have been cut, you 
can import your check data back to GIFTS.

Specific links are available for many popular accounting packages, including 
Blackbaud Accounts Payable, Quicken®, and QuickBooks®.

Document Manager 

The Document Manager takes grantmakers a step closer to the “paperless 
office.” This sophisticated file management system allows you to link 
externally created documents and other files to their associated grantee 
Organization, Contact, or Request.

Reviewers Module

The GIFTS Reviewers Module allows you to schedule reviews, gather 
feedback, interact with reviewers, and make decisions on proposals. You can 
use it to process review packets for external reviewers, or to set up an 
internal review process among your staff members. If you would like your 
reviewers to have access to the system through the Internet, please refer to 
“ReviewerCONNECT” on page 143 for more information.

GIFTS Customizer

The GIFTS Customizer enables you to design additional data entry tabs for 
GIFTS records. In these additional tabs you can display fields containing 
information that is unique to your organization. The custom data entry 
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fields can contain text, numeric, currency, date, or coded values—as well as 
data calculated from other fields in your system, or even live web content.

These custom tabs can be added to Organizations, Contacts, Activities, 
Affiliations, Requirements, Payments, and Requests—in fact, you can set up 
a different custom tab for each Request Type. If you use the optional 
Reviewers Module, you can also customize Review records.

Branch Security

Branch Security is an option that allows grant makers with multiple sites or 
branches and separate giving programs to capture all of their information in 
a centralized database, while preventing users from different branches from 
editing (or viewing, if desired) each other’s data. This security is established 
and maintained from within the GIFTS Administrator Module.

Budget Module 

The Budget Module provides up-to-the-minute financial information about 
budgeted, committed, and paid funds, as well as current budget balances.

Import Module

The standard GIFTS product includes a Matching Gifts Summary import, 
and Employee GIFTS includes a Donor import. If these imports do not meet 
your needs, the Import Module expands your options for importing data 
from external systems into GIFTS. This module includes Detailed Request, 
Detailed Matching Gifts, Organization, Contact, and Grant Summary 
imports.
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GIFTS Connections

GIFTS Connections makes it possible to access and edit data in your GIFTS 
database through a web browser. The GIFTS Connections Server (GCS) 
retrieves data from your GIFTS database and formats it using HTML for 
display in a web page.

In turn, GCS can also receive data from users connecting through the web 
interface and save it to GIFTS. This allows users the flexibility to connect to 
your GIFTS system from anywhere while your organization maintains a 
single database.

The GIFTS Connections Server is the hub of the GIFTS Connections suite 
of products. With the server translating data to browser-ready form—and 
back again—GIFTS Connections modules designed for specific audiences 
are ready to be added. Two modules have so far been released:

MyGIFTS

MyGIFTS is designed to give members and employees of your organization 
convenient and versatile access to your GIFTS database from remote 
locations. Whether connecting through an intranet or over the Internet, 
your users have a way to interact with GIFTS through their web browsers.

MyGIFTS administrators can customize user access and permissions, 
making MyGIFTS a perfect tool for program officers, executives, and casual 
users who need limited, easy-to-use access to GIFTS.

ReviewerCONNECT

If you have the GIFTS Reviewers Module, ReviewerCONNECT gives your 
proposal reviewers convenient and versatile access to your proposals from 
remote locations. Whether connecting through an intranet or over the 
Internet, your reviewers have a way to access, edit, and submit reviews 
through their web browsers.
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System Trade-up and Migration

Trading Up from Essential GIFTS to GIFTS

You can upgrade from Essential GIFTS to the standalone or file server 
version of GIFTS by simply installing a new system configuration file. Once 
provided by MicroEdge and properly installed, the upgrade occurs 
automatically. All existing grant data, codes, document templates, and 
reports continue to operate as before. No database conversion is required. 

Trading Up from Standalone to File Server

To upgrade a standalone GIFTS system to a network file server version, you 
can obtain a new configuration file from MicroEdge and then re-install 
GIFTS with the new configuration. All existing grant data, codes, document 
templates, and reports continue operate as before. No database conversion 
is required.

Trading Up to Microsoft SQL Server or Oracle 
Server

The following points describe how clients can upgrade from a standalone or 
file server version of GIFTS (that uses a Microsoft Access database) to a 
client/server system.

Important: When upgrading from an Access system to either Microsoft SQL 
Server or Oracle server, there may be a significant impact on modified 
standard reports and custom reports. Consider this very carefully before 
upgrading.

❖ Database Conversion: When you purchase a client/server license from 
MicroEdge, you’ll receive a reconfiguration package that includes a utility 
you can use to copy your data from the Access database to the SQL or 
Oracle database.

❖ Impact on Standard Reports: All Access-compatible standard reports are 
replaced by client/server-compatible reports during the reconfiguration 
process. No standard reports are lost; however, since all reports are 
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overwritten, any changes that have been made to the standard reports are 
lost.

❖ Impact on Custom Reports: Business Objects Crystal Reports allows you 
to change the database type for your report. Although this feature can be 
used to convert your reports, it is an advanced feature and is not supported 
by MicroEdge Technical Support. If you need assistance with this process, 
please contact Business Objects directly.

Custom reports created for Microsoft Access systems by MicroEdge are 
not compatible with the client/server systems, and will have to be re-
created. This is a billable service, and the conversion of any critical 
reports should be scheduled well in advance of the “live” date.

❖ Impact on the Crystal Reports: If you use Crystal Reports on any 
computer that is also running GIFTS, please note that for client/server 
systems you must use the Professional version of Crystal Reports.

Migrating Server or Server Operating System

Upon installation, GIFTS creates configuration files that store the location 
of the GIFTS programs, data, and document templates. When you migrate 
your GIFTS system to another file server, or if you upgrade the operating 
system on your file server, you should ensure that these components can be 
found by GIFTS. For more information about migrating GIFTS to a new file 
server, please contact MicroEdge Technical Support.

Important: When migrating to another server or when upgrading to a new 
server operating system, be sure to map the upgraded system’s drive to the 
same drive letter used by the previous system.

If you use the optional GIFTS Document Manager and change the directory 
name or mapped drive letter that externally attached documents are stored 
in, their links to GIFTS must be updated to reflect the new drive mapping.
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Links to External Systems

For a complete list of compatible external programs, please refer to the 
Compatibility Fact Sheet by going to http://www.microedge.com and loggig 
in to the GIFTS PowerME website. 

OLE Links

MicroEdge provides OLE links to Microsoft Word and Microsoft Excel. 
When these products are properly installed, GIFTS can—at the click of a 
button—automatically launch these companion products, export data, and 
run routine tasks such as merging GIFTS data into correspondence.

Commercial Accounting Systems

The GIFTS A/P Module provides built-in links to many popular commercial 
accounting and check writing programs by exporting and importing data 
using ASCII files suitable for use with the supported accounting systems. In 
addition, there is a link with BlackBaud’s Accounts Payable.

Custom Accounting Systems

MicroEdge offers clients the capability to contract with MicroEdge for the 
development of a custom export from GIFTS to any in-house or new 
commercial accounting package. The link will create an ASCII file that 
contains the data that you wish to import into the accounting system. Please 
contact your MicroEdge representative for information about these services. 

Note: MicroEdge Product Specialists can help you define the data elements to 
be exported from and imported into GIFTS. We recommend that you 
consider budgeting for this service.

You may also choose to arrange for the development of an export link from 
your accounting system to GIFTS in order to automate the entry of the 
Check Number and Check Date generated by your accounting system. It is 
the client’s responsibility to contract with the developer of the accounting 
system or a skilled programmer to develop and document this export link in 
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accordance with MicroEdge’s published import specifications. MicroEdge 
does not provide this service.

In some cases, custom accounting links must be reviewed and updated when 
you upgrade your accounting software. If this needs to be done, MicroEdge 
can provided these consulting services for a fee.

Exporting Data

Users can export data from the GIFTS Organizer to Microsoft Excel or an 
HTML file. In addition, the report viewers used by GIFTS for ad hoc 
reports, standard reports, and custom reports enable you to export data to 
the data formats listed in the GIFTS Compatibility Fact Sheet on the GIFTS 
PowerME website.

As with any type of export, some formatting may be lost during the export 
process. 

Linking to Other Products

All versions of GIFTS can be linked in read-only mode to other third party 
products. Clients are responsible for the development, testing, 
documentation, and ongoing support of such links. Clients are also 
responsible for updating such links if MicroEdge modifies database 
structures in future releases of GIFTS.

!
Caution: When linking to other systems, ensure that GIFTS data is not 
modified by any application other than GIFTS. The GIFTS database can be 
corrupted if another application modifies it. As described in the Client 
Resource Guide, MicroEdge will not support your GIFTS software if data is 
entered or modified through any means except the application software 
provided by MicroEdge.
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11 Installation
Impact Analysis

The following impact analyses detail the system files that are installed 
with each MicroEdge application included on the installation 
download. Files are listed according to the directory where they will 
be installed. 

Note: The GIFTS Setup process overwrites existing system files only 
when the file to be installed is dated later than the existing file. 

In This Chapter
GIFTS 6.6 Impact Analysis ...................................................150
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GIFTS 6.6 Impact Analysis

The following tables detail the system files that are installed with GIFTS 6.6 
and Essential GIFTS 6.6. The files are listed according to the directory where 
they will be installed. If no version number is listed for a file, its 
manufacturer did not assign a version number to it.

In cases where the directories differ for computers running different versions 
of Windows, the appropriate directories for each version are noted.

Windows Directory – GIFTS Workstations

This file is installed to the \Windows directory on Windows workstations.

System32 Directory – GIFTS Workstations

On Windows workstations, these are installed to the \Windows\System32 
directory.

Self-Registering Files

Filename Version File Date Size (in Kb)

GiftsCst.DCT 6/14/2000 1

Filename Version File Date Size (in Kb)

AniGIFV6.ocx 2.0.0.19 4/3/2002 36

arpro2.dll 2.3.2264 1/21/2005 1,793

ARVIEW2.OCX 2.3.2264 1/21/2005 599

Atl.dll 3.0.8168.0 6/16/1998 68

c1sizer.ocx 8.0.20071.39 10/2/2006 352

Cfx4032.ocx 4.0.21.0 2/1/2001 557

COMCAT.DLL 5.1.2181.1 7/26/2000 4

Comctl32.ocx 6.0.81.5 5/22/2000 595

Comdlg32.ocx 6.0.84.18 5/7/1999 137

CRYSTL32.OCX 8.0.0.4 12/10/1999 828

DSSOCK32.OCX 1.65.1.1 2/17/1996 48

dzocx32.ocx 1.0.0.5 11/18/1996 72

exclexpt.dll 2.3.2264 1/21/2005 350
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htmlexpt.dll 2.3.2264 1/21/2005 542

https62.ocx 6.2.0.3071 5/29/2008 219

IGToolBars50.ocx 5.0.1.6 3/6/2002 482

ipdaems62.ocx 6.2.0.3071 5/29/2008 169

ipports62.ocx 6.2.0.3071 5/29/2008 165

MEDate.ocx 1.0.0.0 9/30/2004 120

meEmail.dll 1.1 3/22/2006 120

mem32x30.ocx 3.00.38 9/4/2007 320

METCPCommunica
tions.dll

1.0.0.0 10/18/2002 184

METimer.dll 1.0.0.0 10/18/2002 28

MFC40.DLL 4.1.0.6140 7/26/2000 903

MFC42.DLL 6.0.8665.0 7/26/2000 973

Mmail32.ocx 5.1.0.7 2/2/2000 99

MSADODC.OCX 6.0.88.4 5/22/2000 117

MSBIND.DLL 6.0.88.62 7/15/2000 76

mscomctl.ocx 6.00.88.62 5/22/2000 1,042

mshtml.dll 6.0.2800.1170 2/24/2003 2,723

msoutl32.ocx 4.0.29.22 10/6/1999 77

msscript.ocx 1.0.0.7615 8/29/2002 105

MSVBVM50.DLL 5.2.82.44 12/6/1999 1,324

MSVBVM60.DLL 6.0.88.77 5/26/2000 1,356

MSWINSCK.OCX 6.0.89.88 12/6/2000 107

NPO_IGAM_Comp
onent.ocx

1.0.0.0 11/22/2002 804

OC30.DLL 3.20.0.0 5/22/1995 626

oleaut32.dll 2.40.4514.1 7/26/2000 601

OLEPRO32.DLL 5.1.4514.1 7/26/2000 161

OUTSIDEX.OCX 8.1.9.4408 2/20/2007 200

pdfexpt.dll 2.3.2264 1/21/2005 366

Richtx32.ocx 6.0.88.4 5/22/2000 200

rtfexpt.dll 2.3.2264 1/21/2005 206

sccanno.dll 12/8/2006 45

scrrun.dll 5.1.0.5010 7/22/2002 145

SfxBar.dll 1.0.15.1 1/19/2001 127

shdocvw.dll 6.0.2800.1170 2/24/2003 1,309

smtps62.ocx 6.2.0.3071 5/29/2008 189

Filename Version File Date Size (in Kb)
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soaps62.ocx 6.2.0.3071 5/29/2008 247

Spell8.ocx 8.0.20071.65 10/2/2006 291

ssdw3bo.ocx 3.1.3.4 3/19/2001 865

SSLstBar.ocx 1.0.2.5 3/29/1999 253

ssmedt32.dll 1.0.0.38 10/26/1998 71

ssprn32.dll 1.0.0.34 5/6/1998 71

ssr2c.dll 1.0.2.14 3/8/2001 96

Tab32x30 3.1.0.0 5/30/2000 430

textexpt.dll 2.3.2264 1/21/2005 126

THREED20.OCX 2.0.1.15 7/1/1997 324

tidate8.ocx 8.0.20071.24 12/20/2006 369

tiffexpt.dll 2.3.2264 1/21/2005 254

tishare8.dll 8.0.20071.24 12/20/2006 131

titime8.ocx 8.0.20071.24 12/20/2006 344

TList7.ocx 7.52 12/29/2004 905

Vsflex8.ocx 8.0.20071.237 12/19/2006 631

vsprint8.ocx 8.0.20071.130 12/5/2006 459

vsvport8.ocx 8.0.20071.130 12/5/2006 233

webuploads62.ocx 6.2.2286.0 4/5/2006 227

webupls62.ocx 6.2.0.3071 5/29/2008 239

XceedSco.dll 1.0.80 6/26/2001 241

XceedZip.dll 4.2.20.61 1/9/2001 316

Filename Version File Date Size (in Kb)

apigid32.dll 4.0.0.0 10/6/1999 111

ASYCFILT.DLL 2.40.4514.1 7/26/2000 141

comctl32.dll 5.81.4807.2300 7/23/2001 541

compobj.dll 2.10.35.35 11/29/2000 30

crbas19.dll 4.20.0.12 7/25/2003 372

crbas19r.dll 4.20.0.12 7/25/2003 40

cror818.dll 4.10.0.4 4/9/2002 212

cror818r.dll 4.10.0.4 4/9/2002 20

cror818s.dll 4.10.0.4 4/9/2002 52

cror819.dll 4.20.0.12 8/6/2003 224

cror819r.dll 4.20.0.12 8/6/2003 20

Filename Version File Date Size (in Kb)
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cror819s.dll 4.20.0.12 8/6/2003 52

crora18.dll 4.10.0.4 4/9/2002 280

crora18r.dll 4.10.0.4 4/9/2002 24

crora18s.dll 4.10.0.4 4/9/2002 52

CRPE32.DLL 8.0.0.441 6/5/2000 5,216

crutl19.dll 19.0.0.7 8/6/2003 376

crutl19r.dll 19.0.0.7 8/6/2003 24

CTL3D32.DLL 2.31.0.0 9/16/1995 27

cxlibw-1-6.dll 10.0.0.388 12/9/2003 1,221

dzip32.dll 3.0.0.15 4/14/1997 122

Edt32x30.ocx 3.0.0.38 9/4/2007 1,300

GAPI32.DLL 5.5.2803.0 12/1/1999 96

gdiplus.dll 5.1.3102.1360 5/4/2004 1,607

idsnotes.dll 1.0.0.1 10/18/1999 44

IMM32.DLL 5.1.2180.1 7/26/2000 94

MFCANS32.DLL 3.2.2.0 10/6/1999 131

mshtml.tlb 6.0.2800.1106 8/29/2002 1,319

Msldbusr.dll 1.0.0.0 11/9/1998 19

msvcirt.dll 4.20.0.6201 8/3/1996 73

msvcp60.dll 6.0.8168.0 2/1/2000 393

msvcrt.dll 6.1.8637.0 7/26/2000 289

msvcrt20.dll 2.12.0.0 7/26/2000 248

msvcrt40.dll 4.2000.0.6201 7/26/2000 64

ole2.dll 2.10.35.35 11/29/2000 39

ole2disp.dll 2.10.3050.1 11/29/2000 166

ole2nls.dll 2.10.3050.1 11/29/2000 150

OLEDLG.DLL 5.1.2134.1 7/26/2000 116

qecr.lic 3/31/1998 1

RICHED20.DLL 5.30.23.1203 7/26/2000 422

RICHED32.DLL 5.1.2134.1 7/26/2000 4

shlwapi.dll 6.0.2800.1106 8/29/2002 393

ssdw3b32.ocx 3.1.3.4 3/19/2001 865

STDOLE2.TLB 2.40.4514.1 7/26/2000 17

storage.dll 2.10.35.35 11/29/2000 5

tibase8.dll 8.0.20071.24 12/20/2006 549

typelib.dll 2.10.3029.1 11/29/2000 174

unicows.dll 1.0.4018.0 4/21/2003 240

Filename Version File Date Size (in Kb)
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These files are related to the Outside In viewer installed with GIFTS. They 
are installed to the \Windows\OutsideIn or \WINNT\OutsideIn directory, but 
can be moved to a different directory in the workstation’s system path.

usp10.dll 1.409.2600.1106 8/29/2002 332

VBAMAP32.DLL 2.1.0.0 8/11/1995 15

winsock.dll 3.10.0.103 8/23/2001 3

Filename Version File Date Size (in Kb)

adinit.dat 12/8/2006 260

CMMAP000.BIN 12/8/2006 364

DEBMP.DLL 8.1.9.4389 2/20/2007 77

DEHEX.DLL 8.1.0.4037 12/8/2006 25

DEMET.DLL 8.1.9.4418 2/20/2007 237

DESS.DLL 8.1.9.4418 2/20/2007 145

DETREE.DLL 8.1.5.4266 12/8/2006 77

DEWP.DLL 8.1.9.4418 2/20/2007 213

IBFPX2.FLT 12/8/2006 77

IBGP42.FLT 8.1.0.4037 12/8/2006 37

IBJPG2.FLT 8.1.0.4037 12/8/2006 61

IBPCD2.FLT 8.1.0.4037 12/8/2006 125

IBPSD2.FLT 8.1.0.4037 12/8/2006 37

IBXBM2.FLT 8.1.0.4037 12/8/2006 33

IBXPM2.FLT 8.1.0.4037 12/8/2006 53

IBXWD2.FLT 8.1.0.4037 12/8/2006 37

IMCD32.FLT 8.1.0.4037 12/8/2006 93

IMCD42.FLT 8.1.0.4037 12/8/2006 109

IMCD52.FLT 8.1.0.4037 12/8/2006 109

IMCD62.FLT 8.1.0.4037 12/8/2006 125

IMCD72.FLT 8.1.0.4037 12/8/2006 189

IMCD82.FLT 8.1.0.4037 12/8/2006 189

IMCDR2.FLT 8.1.0.4044 12/8/2006 33

IMCM52.FLT 8.1.0.4037 12/8/2006 53

IMCM72.FLT 8.1.0.4037 12/8/2006 97

IMCMX2.FLT 8.1.0.4037 12/8/2006 33

Filename Version File Date Size (in Kb)
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IMDSF2.FLT 8.1.0.4037 12/8/2006 101

IMFMV2.FLT 8.1.0.4037 12/8/2006 61

IMGDF2.FLT 8.1.0.4037 12/8/2006 61

IMGEM2.FLT 8.1.0.4037 12/8/2006 45

IMIGS2.FLT 8.1.0.4037 12/8/2006 93

IMMET2.FLT 8.1.0.4037 12/8/2006 93

IMPIF2.FLT 8.1.0.4037 12/8/2006 57

IMPS_2.FLT 8.1.0.4044 12/8/2006 97

IMPSI2.FLT 8.1.0.4410 2/20/2007 517

IMPSZ2.FLT 8.1.0.4037 12/8/2006 33

IMRND2.FLT 8.1.0.4037 12/8/2006 37

ISGDI32.DLL 8.1.0.4037 12/8/2006 1,133

LTSCSN10.DLL 1.2.7.82 12/8/2006 103

LWPAPIN.DLL 12/8/2006 1,531

LWPAPIPN.DAT 12/8/2006 183

OSWIN32.DLL 8.1.9.4407 2/20/2007 41

SCCANNO.DLL 8.1.5.4149 12/8/2006 45

SCCCA.DLL 8.1.5.4266 12/8/2006 33

SCCCH.DLL 8.1.9.4389 2/20/2007 73

SCCDU.DLL 8.1.9.4422 2/20/2007 261

SCCFA.DLL 8.1.9.4419 2/20/2007 93

SCCFI.DLL 8.1.9.4421 2/20/2007 89

SCCFMT.DLL 8.1.5.4189 12/8/2006 53

SCCFUT.DLL 8.1.9.4418 2/20/2007 205

SCCIND.DLL 8.1.9.4418 2/20/2007 53

SCCLO.DLL 8.1.9.4077 2/20/2007 129

SCCOLE.DLL 8.1.9.4389 2/20/2007 29

SCCTA.DLL 8.1.5.4204 12/8/2006 29

SCCUT.DLL 8.1.9.4421 2/20/2007 405

SCCVW.DLL 8.1.9.4407 2/20/2007 205

VSACAD.DLL 8.1.5.4287 12/8/2006 1,397

VSACS.DLL 8.1.0.4037 12/8/2006 41

VSAMI.DLL 8.1.0.4051 12/8/2006 69

VSBDR.DLL 8.1.0.4037 12/8/2006 29

VSBMP.DLL 8.1.9.4407 2/20/2007 37

VSCGM.DLL 8.1.0.4037 12/8/2006 49

VSDBS.DLL 8.1.0.4037 12/8/2006 29

Filename Version File Date Size (in Kb)
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VSDEZ.DLL 8.1.0.4037 12/8/2006 33

VSDIF.DLL 8.1.0.4037 12/8/2006 29

VSDRW.DLL 8.1.0.4037 12/8/2006 37

VSDX.DLL 8.1.0.4037 12/8/2006 33

VSDXF.DLL 8.1.9.4389 8/21/2002 73

VSEMF.DLL 8.1.0.4037 2/20/2007 57

VSEN4.DLL 8.1.0.4037 12/8/2006 33

VSENS.DLL 8.1.0.4037 12/8/2006 33

VSENW.DLL 8.1.9.4389 12/8/2006 33

VSESHR.DLL 8.1.0.4037 2/20/2007 157

VSEXE2.DLL 8.1.5.4204 12/8/2006 49

VSFAX.DLL 8.1.9.4389 2/20/2007 29

VSFCD.DLL 8.1.0.4037 12/8/2006 33

VSFCS.DLL 8.1.5.4234 12/8/2006 37

VSFFT.DLL 8.1.0.4037 12/8/2006 33

VSFLW.DLL 8.1.5.4234 12/8/2006 109

VSFWK.DLL 8.1.0.4037 12/8/2006 41

VSGDSF.DLL 8.1.9.4429 2/20/2007 77

VSGIF.DLL 8.1.5.4234 12/8/2006 33

VSGZIP.DLL 8.1.5.4226 12/8/2006 37

VSHGS.DLL 8.1.0.4037 12/8/2006 49

VSHTML.DLL 8.1.9.4417 2/20/2007 93

VSHWP.DLL 8.1.9.4421 2/20/2007 77

VSHWP2.DLL 8.1.9.4259 12/8/2006 73

VSICH6.DLL 8.1.0.4037 12/8/2006 57

VSICH.DLL 8.1.9.4423 2/20/2007 89

VSIMG.DLL 8.1.0.4037 12/8/2006 29

VSIWP.DLL 8.1.0.4037 12/8/2006 33

VSJBG2.DLL 8.1.9.4389 2/20/2007 33

VSJW.DLL 8.1.0.4037 12/8/2006 33

VSLEG.DLL 8.1.0.4037 12/8/2006 37

VSLWP.DLL 8.1.9.4407 2/20/2007 137

VSLZH.DLL 8.1.0.4037 12/8/2006 41

VSM11.DLL 8.1.0.4037 12/8/2006 33

VSMANU.DLL 8.1.0.4037 12/8/2006 41

VSMCW.DLL 8.1.0.4037 12/8/2006 41

VSMIF.DLL 8.1.9.4389 2/20/2007 185

Filename Version File Date Size (in Kb)
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VSMIME.DLL 8.1.9.4077 2/20/2007 81

VSMM.DLL 8.1.0.4037 12/8/2006 37

VSMM4.DLL 8.1.0.4037 12/8/2006 37

VSMMFN.DLL 8.1.0.4037 12/8/2006 33

VSMP.DLL 8.1.0.4037 12/8/2006 33

VSMPP.DLL 8.1.5.4282 12/8/2006 125

VSMSG.DLL 8.1.9.4389 2/20/2007 65

VSMSW.DLL 8.1.5.4234 12/8/2006 45

VSMWKD.DLL 8.1.9.4389 2/20/2007 29

VSMWKS.DLL 8.1.9.4389 2/20/2007 29

VSMWP2.DLL 8.1.0.4037 12/8/2006 45

VSMWPF.DLL 8.1.0.4037 12/8/2006 37

VSMWRK.DLL 8.1.0.4037 12/8/2006 33

VSOW.DLL 8.1.0.4037 12/8/2006 29

VSPBM.DLL 8.1.0.4037 12/8/2006 29

VSPCL.DLL 8.1.0.4037 12/8/2006 29

VSPCX.DLL 8.1.5.4234 12/8/2006 33

VSPDF.DLL 8.1.9.4427 2/20/2007 157

VSPDFI.DLL 8.1.9.4417 2/20/2007 33

VSPDX.DLL 8.1.0.4037 12/8/2006 33

VSPFS.DLL 8.1.0.4037 12/8/2006 41

VSPGL.DLL 8.1.0.4037 12/8/2006 57

VSPIC.DLL 8.1.0.4037 12/8/2006 29

VSPICT.DLL 8.1.9.4427 2/20/2007 53

VSPNG.DLL 8.1.9.4389 2/20/2007 45

VSPNTG.DLL 8.1.0.4037 12/8/2006 29

VSPP12.DLL 8.1.9.4417 2/20/2007 73

VSPP2.DLL 8.1.9.4077 2/20/2007 65

VSPP7.DLL 8.1.9.4389 2/20/2007 73

VSPP97.DLL 8.1.9.4417 2/20/2007 145

VSPPL.DLL 8.1.0.4037 12/8/2006 37

VSPSP6.DLL 8.1.0.4037 12/8/2006 157

VSPST.DLL 8.1.5.4282 12/8/2006 69

VSPSTF.DLL 8.1.5.4149 12/8/2006 37

VSQA.DLL 8.1.0.4037 12/8/2006 33

VSQAD.DLL 8.1.0.4037 12/8/2006 37

VSQP6.DLL 8.1.0.4037 12/8/2006 49

Filename Version File Date Size (in Kb)
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VSQP9.DLL 8.1.9.4417 2/20/2007 65

VSRAS.DLL 8.1.0.4037 12/8/2006 29

VSRBS.DLL 8.1.0.4037 12/8/2006 33

VSRFT.DLL 8.1.0.4037 12/8/2006 33

VSRFX.DLL 8.1.0.4037 12/8/2006 33

VSRTF.DLL 8.1.9.4417 2/20/2007 145

VSSAM.DLL 8.1.0.4037 12/8/2006 33

VSSC5.DLL 8.1.5.4247 12/8/2006 37

VSSDW.DLL 8.1.0.4037 12/8/2006 33

VSSHW3.DLL 8.1.5.4247 12/8/2006 41

VSSMD.DLL 8.1.0.4037 12/8/2006 29

VSSMS.DLL 8.1.0.4037 12/8/2006 33

VSSMT.DLL 8.1.0.4037 12/8/2006 33

VSSNAP.DLL 8.1.0.4037 12/8/2006 33

VSSO6.DLL 8.1.9.4417 2/20/2007 177

VSSOC.DLL 8.1.6.4351 12/8/2006 37

VSSOI.DLL 8.1.5.4266 12/8/2006 37

VSSOI6.DLL 8.1.5.4259 12/8/2006 165

VSSOW.DLL 8.1.0.4037 12/8/2006 33

VSSPT.DLL 8.1.0.4037 12/8/2006 33

VSSWF.DLL 8.1.5.4247 12/8/2006 33

VSTAZ.DLL 8.1.0.4037 12/8/2006 37

VSTEXT.DLL 8.1.9.4389 2/20/2007 33

VSTGA.DLL 8.1.5.4234 12/8/2006 29

VSTIF6.DLL 8.1.9.4417 2/20/2007 69

VSTW.DLL 8.1.0.4037 12/8/2006 37

VSTXT.DLL 8.1.0.4037 12/8/2006 37

VSVCRD.DLL 8.1.0.4037 12/8/2006 65

VSVISO.DLL 8.1.5.4282 12/8/2006 141

VSVW3.DLL 8.1.0.4037 12/8/2006 33

VSW12.DLL 8.1.9.4417 2/20/2007 129

VSW6.DLL 8.1.9.4389 2/20/2007 117

VSW97.DLL 8.1.9.4417 2/20/2007 149

VSWBMP.DLL 8.1.0.4037 12/8/2006 29

VSWG2.DLL 8.1.0.4037 12/8/2006 45

VSWK4.DLL 8.1.5.4234 12/8/2006 85

VSWK6.DLL 8.1.5.4204 12/8/2006 113

Filename Version File Date Size (in Kb)
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The self-registering Crystal files listed below are installed to the following 
directory on each workstation: C:\Program Files\Common Files\Crystal 
Decisions\3.0\bin.

VSWKS.DLL 8.1.5.4247 12/8/2006 45

VSWM.DLL 8.1.0.4037 12/8/2006 33

VSWMF.DLL 8.1.9.4417 2/20/2007 41

VSWML.DLL 8.1.0.4037 12/8/2006 57

VSWORD.DLL 8.1.9.4417 2/20/2007 77

VSWORK.DLL 8.1.9.4389 2/20/2007 37

VSWP5.DLL 8.1.9.4389 2/20/2007 69

VSWP6.DLL 8.1.9.4417 2/20/2007 89

VSWPF.DLL 8.1.0.4037 12/8/2006 33

VSWPG2.DLL 8.1.9.4417 2/20/2007 57

VSWPG.DLL 8.1.0.4037 12/8/2006 49

VSWPL.DLL 8.1.0.4037 12/8/2006 37

VSWPW.DLL 8.1.0.4037 12/8/2006 57

VSWS.DLL 8.1.0.4037 12/8/2006 37

VSWS2.DLL 8.1.0.4037 12/8/2006 33

VSXL12.DLL 8.1.9.4422 2/20/2007 149

VSXL5.DLL 8.1.9.4417 2/20/2007 181

VSXML.DLL 8.1.9.4389 2/20/2007 29

VSXY.DLL 8.1.0.4037 12/8/2006 37

VSYIM.DLL 8.1.0.4044 12/8/2006 33

VSZIP.DLL 8.1.0.4037 12/8/2006 37

WVCORE.DLL 8.1.5.4149 12/8/2006 65

Filename Version File Date Size (in Kb)

crviewer.dll 11.0.0.2385 2/12/2007 13007

craxdrt.dll 11.0.0.2381 2/8/2007 8213

Filename Version File Date Size (in Kb)
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Other Crystal files are installed here: C:\Windows\Crystal.

Filename File Date Size (in Kb)

u25total.dll 03/31/1998 60

U2fdif.dll 12/07/1999 37

U2fhtml.dll 01/06/2000 33

U2frtf.dll 01/26/2000 123

U2fwks.dll 12/07/1999 41

U2fwordw.dll 12/07/1999 106

U2fxls.dll 01/26/2000 209

u2lsamp1.dll 12/07/1999 25

U2LSTR.DLL 09/06/1995 33

U2LSTRNG.DLL 11/06/1995 27

u2ltec1.dll 09/06/1995 29
160 GIFTS 6.6 Impact Analysis



12 Custom
Reports

This chapter applies only to users who use or intend to use Business 
Objects® Crystal Reports or another third-party report writer to 
create custom reports for GIFTS. If you do not intend to use Crystal 
Reports or another report writer, you may ignore this chapter.

In This Chapter
Creating Custom Reports.....................................................162

How GIFTS Upgrades Affect Custom Reports....................163

Compatibility with Crystal Reports .....................................164

Upgrades to Crystal Reports ................................................165
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Creating Custom Reports

To meet your reporting needs, the GIFTS Report Library includes more 
than 300 standard reports. For a complete list of these reports, please refer to 
Using GIFTS Reports. 

You can also generate ad hoc reports from the GIFTS Organizer, as 
described in the GIFTS User’s Guide. The ad hoc reporting feature was 
significantly upgraded with the release of GIFTS 6, including enhanced 
options for formatting, sorting, and grouping data in reports—as well as an 
expanded scope of fields that you can report on.

If you need additional reports, you can use any third party report designer 
package to create GIFTS reports. MicroEdge can support your use of these 
products by providing detailed documentation of the GIFTS database 
structures and by answering questions related to that document.

MicroEdge also offers a fee-based service to develop custom reports and to 
upgrade client-modified reports. You should schedule the creation or 
conversion of any critical reports well in advance of the “live” date. For 
detailed information about our support policies and programming services, 
please refer to the Client Resource Guide.

Note: If you want to modify the standard reports provided in the GIFTS 
Report Library, you must use Crystal Reports. Please refer to “Compatibility 
with Crystal Reports” on page 164 for compatibility information.
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How GIFTS Upgrades Affect Custom Reports

When you upgrade any GIFTS or Essential GIFTS product, there is the 
potential for incompatibilities with custom reports and/or standard reports 
that have been modified by Crystal Reports.

Impact on All Custom Reports

Changes to the functionality and database structure of GIFTS may 
necessitate changes to your custom reports. To determine whether database 
changes to GIFTS will impact your custom reports, review the Database 
Schema document for the version of GIFTS to which you plan to upgrade.

Note: The Database Schema is currently not available in electronic format. 
Please contact MicroEdge Technical Support to request this document.

Impact on Crystal Reports Users

The version of Crystal Reports you are using must always be supported by 
your GIFTS installation. GIFTS 6.6 is compatible with the versions of 
Crystal Reports listed in the Compatibility Fact Sheet available on the GIFTS 
PowerME website. Be sure to choose the appropriate version of Crystal 
Reports when you upgrade GIFTS.

New versions of GIFTS often include new standard reports or updates to 
existing standard reports. If you have modified standard reports, ensure that 
the modified version does not have the same filename as the original 
template. If you do not use a new filename, the installation process may 
overwrite your custom report as it updates your standard reports.
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Compatibility with Crystal Reports

This section applies to clients who either:

❖ Plan to install both Crystal Reports and GIFTS on the same workstation

❖ Plan to use Crystal Reports to create or modify reports

All other clients can skip this section.

The GIFTS installation process installs Crystal Reports viewer to run many 
of the standard reports in the GIFTS Report Library. Due to the presence of 
this viewer, GIFTS is not compatible with versions of Crystal Reports that 
are not listed on the GIFTS 6.6 Compatibility Fact Sheet by going to the 
GIFTS PowerME website.

!
Caution: The presence of an incompatible version of Crystal Reports on a 
GIFTS workstation will interfere with the proper performance of both 
GIFTS and Crystal Reports.

MicroEdge recommends the Standard Edition of Crystal Reports for use 
with standalone and file server versions of GIFTS. The Professional Edition 
is required for clients using the client/server version of GIFTS.

When a new version of Crystal Reports becomes available, MicroEdge 
schedules a thorough quality assurance testing cycle to ensure that GIFTS 
and the GIFTS standard reports are compatible with the new version. 

In some cases, the upgrade requires adjustments to the standard reports; in 
addition, technical problems may be identified, researched, and resolved in 
coordination with Business Objects.

Note that there is often a reasonable delay between the release of a Crystal 
Reports upgrade and its certification by MicroEdge. This is the time needed 
to complete quality assurance testing with the standalone, file server, 
Microsoft SQL Server, and Oracle server versions of GIFTS.
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Upgrades to Crystal Reports

This section applies to clients who use Crystal Reports to create or modify 
reports, and who wish to upgrade their Crystal Reports software to a newer 
version. All other clients can skip this section.

When you upgrade Crystal Reports, there is the potential for 
incompatibilities with your custom reports and standard reports that you 
have modified. Reports may have formatting problems, calculation errors, 
or other problems.

Important: Be sure to thoroughly review the Compatibility Fact Sheet for your 
version of GIFTS, and the information in this section, to determine the 
impact on your operation before upgrading. Do not upgrade to a new 
version of Crystal Reports without first ensuring that it is fully tested and 
certified as compatible with GIFTS.

MicroEdge’s experience to date has been that most custom reports convert 
without any problems. When report adjustments are required, they have 
proven to be relatively simple when made by technical staff with expertise in 
Crystal Report design and testing. Examples of these differences include 
skipping blank lines and the omission of totals.

Important: Be sure to review and test all of your custom reports when you 
upgrade to a new version of Crystal Reports. You should also test all custom 
or modified reports created by MicroEdge.
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